About OmniUpdate, Inc.

OmniUpdate® is the leading web content management system (CMS) provider for higher education. The company focuses on providing an exceptional product and customer experience to its OU Campus™ CMS users who manage more than 700 web and mobile sites in the U.S. and around the world. OU Campus is secure and scalable, server and platform independent, and seamlessly integrates with other enterprise campus systems. It provides college and university web developers, administrators, and marketers with the user-friendly tools and deployment flexibility they need to achieve excellence. For more information, visit [www.omniupdate.com](http://www.omniupdate.com).

About This Guide

The End-User Reference Guide provides information about using OU Campus including how to get started with editing, reviewing, and publishing pages and other content.

OU Campus Support

The Support site is available to everyone and users are encouraged to visit and browse the site for information. An institution's administrators are also available if the answer cannot be found on the Support site or further explanation and clarification is needed. Administrators may contact the OmniUpdate Support Team. Ways to access the OU Campus support documentation include:

- Support site: [https://support.omniupdate.com/](https://support.omniupdate.com/)
- The help link in the main interface of OU Campus
- The WYSIWYG Help link
- Help links embedded in the system
- Text instructions are provide onscreen for specific fields and functionality

Conventions

Shorthand for navigation through the OU Campus CMS is indicated with a greater-than sign and bolded: > For example, Setup > Sites. Code snippets use Courier New and a shaded background.
Contents

About Users.......................................................... 7
Overview.................................................................. 7

Log In........................................................................ 8
Overview.................................................................. 8
About DirectEdit...................................................... 8
Editing a Page with DirectEdit.................................. 8
Logging Out............................................................. 9
Reset Password...................................................... 9
Failed Logins and User Lockouts......................... 11

Checked Out/In......................................................... 12
Overview.................................................................. 12
Page Status Indicators in File Navigation Sidebar..... 12
Checked-Out Pages in Gadgets Sidebar..................... 13
Checking In a Page.................................................... 14
Behaviors of Checked Out Pages.............................. 14
Available Actions for a Locked Page........................ 14
Best Practices.......................................................... 14

Drag and Drop.......................................................... 15
Overview.................................................................. 15
The Drop Zone........................................................ 15
Moving Content with Drag and Drop....................... 16
Uploading Content with Drag and Drop................... 17
Inserting Content with Drag and Drop..................... 18

WYSIWYG Editor....................................................... 20
Overview.................................................................. 20
Toolbars and Tools................................................... 21
  JustEdit Toolbar.................................................... 21
  Old WYSIWYG Toolbar.......................................... 22
  Toolbar Functionality.......................................... 22

Toolbar Options....................................................... 23
Overview.................................................................. 23
  Toolbar Row 1...................................................... 23
  Toolbar Row 2...................................................... 23
  Toolbar Row 3...................................................... 23
  File Tools (Save, Save As, Revert, Restore)........... 24
  Cut, Copy, Paste, Find, Replace.......................... 24
  Undo Redo Functions.......................................... 26
  Spell Check....................................................... 26
  Remove Formatting.............................................. 27
  Font Formatting.................................................. 27
  Lists, Indents...................................................... 28
  Text Placement (Vertical)..................................... 29
  Align, Justify (Horizontal)................................. 29
  Link Tools, WYSIWYG Help Documentation............ 30
  Font Properties (Family, Size, Format, Styles)........ 33
  Text Color, Text Background.............................. 35
  Images/Media..................................................... 36
  Miscellaneous Functionality............................... 37
  Table Tools (Classic Only)................................. 40
  Form Tools (Classic Only)................................. 42

WYSIWYG Spell Check............................................. 43
Overview.................................................................. 43
Correcting Misspelled Words................................. 44
Adding Words........................................................ 45
Browser Specific Spell Check vs. OU Campus Spell Check.. 45

Insert/Edit Link....................................................... 46
Overview.................................................................. 46
Inserting an Internal Link........................................ 46
  Linking to an External Page................................. 49
  Linking to an Unpublished File............................. 49
  Linking Across Sites within an Account.................. 49
Links and Dependency Manager.............................. 49
  Broken Links...................................................... 50
General Tab............................................................ 51
  Link URL............................................................. 51
  Target................................................................. 51
  Title................................................................. 52
  Class................................................................. 52
Advanced Tab........................................................ 52
  HTML5 and Pre-HTML5/XHTML............................ 54
  Defining a Hyperlink........................................... 54
More Options for Inserting and Using Links.............. 66

Insert/Edit Image................................................... 67
Overview.................................................................. 67
Inserting an Image.................................................. 67
Editing an Inserted Image........................................ 70
Additional Information and Reminders..................... 73
Decorative Images .......................................................... 73
Using Decorative Images .................................................. 73
Appearance Tab .................................................................. 73
Advanced Tab ...................................................................... 75
Swap Image ......................................................................... 75
Miscellaneous ..................................................................... 76
Image Map ........................................................................... 77
How to Add a Mapped Image ............................................... 77
Long Description .................................................................. 78
Image Editor ........................................................................ 79
Overview ............................................................................. 79
Accessing the Image Editor ................................................ 80
Image Editor Tools .............................................................. 81
Resize .................................................................................. 81
Crop .................................................................................... 82
Rotate .................................................................................. 83
Zoom .................................................................................... 84
Undo/Redo ............................................................................ 85
Final Notes ............................................................................ 85
Insert/Edit Embedded Media ................................................. 86
Overview ............................................................................. 86
Inserting Media From OU Campus ........................................ 86
Inserting Media from an External Source ............................ 90
General Tab ........................................................................ 92
Source/Embed Code ............................................................. 92
Final Notes/Troubleshooting ............................................... 94
Rename ............................................................................... 96
Overview ............................................................................. 96
Renaming a File .................................................................. 96
Copy .................................................................................... 98
Overview ............................................................................. 98
Copying Files ...................................................................... 98
Copying Files from the Pages List View ............................ 98
Copying Files by Drag and Drop ....................................... 99
Move ................................................................................... 102
Overview ............................................................................. 102
Moving a Single File ........................................................... 102
Moving a File from the Pages List View ............................ 102
Moving a File using Drag and Drop ................................... 103
Moving Multiple Files ......................................................... 105
Recycle ............................................................................... 108
Overview ............................................................................. 108
Moving a File to the Recycle Bin ........................................ 108
Delete ............................................................................... 110
Overview ............................................................................. 110
Deleting a File ..................................................................... 110
Deleting Multiple Files ....................................................... 110
Deleting a Directory ............................................................ 111
Review ............................................................................... 112
Overview ............................................................................. 112
Preview ............................................................................... 114
Overview ............................................................................. 114
Previewing a Page .............................................................. 114
Multi-Output Preview ......................................................... 114
Multi-Browser Preview ....................................................... 115
Publish Target ..................................................................... 115
Page Check ......................................................................... 116
Overview ............................................................................. 116
Running Page Check .......................................................... 116
From the Pages List View ................................................ 116
From the Page View .......................................................... 116
Final Check ......................................................................... 118
Page Check Options ............................................................ 118
Analyzing Results of the Error Reports ............................ 119
Enabling Page Check in User Settings ............................... 119
W3C Validation .................................................................... 121
Overview ............................................................................. 121
Performing a W3C Validation ............................................. 123
W3C Validation Results ....................................................... 124
Spell Check ........................................................................ 125
Overview ............................................................................. 125
Spell Check in the Page Check Modal ............................... 125
Spell Check in the Final Check Modal ............................... 126
Spell Check in WYSIWYG Editor ....................................... 126
Spell Check Results Modal ............................................... 127
Performing a Spell Check .................................................. 128
Link Check ......................................................................... 130
Overview ............................................................................. 130
Performing a Link Check .................................................. 131
Link Check Results ............................................................. 132
Show Results ..................................................................... 133
Accessibility Check ........................................ 135
Overview .................................................. 135
Performing an Accessibility Check ............................... 137
Accessibility Check Results ...................................... 137
Known Problems ............................................. 138
Likely Problems .............................................. 139
Potential Problems ........................................... 140
Exceptions .................................................. 140
Versions .................................................... 142
Overview .................................................. 142
Saving a New Version ......................................... 142
Navigating to Versions ....................................... 143
From the Folder Structure ..................................... 143
From Preview or Edit ........................................ 143
Filtering Versions ............................................ 143
Comparing Versions ......................................... 143
Comparing with Production Version ......................... 144
Comparing with a Previous Version ........................ 144
Sorting Versions ............................................. 144
Viewing a Revision .......................................... 145
Viewing a Page Version ...................................... 145
Viewing the Source ......................................... 146
Reverting to a Version ...................................... 146
Compare ................................................... 148
Overview .................................................. 148
Versions Screen ............................................. 148
Comparing Versions ......................................... 149
Comparing to Live .......................................... 149
Comparing with a Previous Version ........................ 149
Examples and Legends ...................................... 150
Production Page ............................................ 150
Example of Live Version Comparison ....................... 151
Source and Other Versions ................................ 151
Example of Source Comparison ............................ 152
Final Words ............................................... 152
Publish .................................................... 153
Overview .................................................. 153
Binary Files and Publishing .................................. 153
Assets and Publishing ..................................... 153
"Unpublishing" a File: About Recycle, Delete, and Restore .................................................. 154
Publishing a Page .......................................... 155
Overview .................................................. 155
Publish Modal Reference .................................... 157
Final Check Tab ............................................. 157
Schedule Tab ................................................ 158
Social Media Tab .......................................... 158
Selecting a Publish Target .................................. 158
Final Check ................................................ 160
Overview .................................................. 160
Running Final Check ....................................... 160
Enforcing Final Check ..................................... 161
Schedule .................................................. 163
Overview .................................................. 163
Schedule Tab ................................................ 163
Performing a Scheduled Publish ......................... 165
Removing a Scheduled Publish .......................... 165
Submit for Approval ...................................... 166
Overview .................................................. 166
Sending for Approval ...................................... 167
Workflow 101 Video ....................................... 168
New Content ............................................. 169
Overview .................................................. 169
New Folder vs. New Section .............................. 169
Creating New Content .................................... 170
Example of New Content Drop-Down Menu ............. 170
Example of New Content Modal .......................... 171
Creating a New Page ...................................... 173
Overview .................................................. 173
New Page Creation Options ................................ 173
New Page Modal .......................................... 175
Creating a New Page .................................... 176
Creating a New Page Video .............................. 177
Upload and Edit Image .................................... 178
Overview .................................................. 178
Selecting and Uploading the Image ....................... 178
Editing the Image ......................................... 180
Creating Assets .......................................... 181
Overview .................................................. 181
Creating a New Asset ..................................... 181
Asset Info Panel .......................................... 182
Access Settings Panel .................................... 183
Asset Content Panel ...................................... 183
Inserting Assets .......................................... 185
Overview .................................................. 185
Inserting an Asset with the WYSIWYG Editor ........................................... 185
Inserting an Asset Only Region .................................................. 186
Inserting an Asset with the Source Editor ...................................... 187

Dashboard ............................................................................ 189
Overview ................................................................................. 189
Dragging Dashboard Gadgets .................................................. 190
Overview ................................................................................. 191
Workflow ................................................................................ 191
Inbox ...................................................................................... 191
Configure Dashboard .............................................................. 191
Gadgets .................................................................................. 191

Workflow ............................................................................ 192
Overview ................................................................................. 192
Workflow Screen .................................................................... 192
File .......................................................................................... 193
Status ...................................................................................... 193
View ........................................................................................ 194
New Messages ........................................................................ 194
Archive .................................................................................... 195

Inbox ...................................................................................... 196
Overview ................................................................................. 196
Composing Messages .............................................................. 196
Viewing, Replying to, and Deleting Messages ......................... 199
Sent .......................................................................................... 200
Forwarding a Message ............................................................ 200

Gadgets ............................................................................... 202
Overview ................................................................................. 202
Video ....................................................................................... 202
Gadget Configuration .............................................................. 202
Dashboard Gadgets ................................................................. 203
Configuring the Dashboard ...................................................... 204
Rearranging Dashboard Gadgets ............................................... 205
Gadgets Sidebar ..................................................................... 206
Gadget Sidebar Icon Reference ................................................. 206
Choosing Gadgets on the Gadget Sidebar .................................. 208
Rearranging Sidebar Gadgets .................................................... 210
About Users

Overview

OU Campus provides users an easy way to manage web pages. With the ability to login directly from the institution’s website, it is easy to navigate to the page to be edited. Once logged in, users can simply click on the area to edit, and they are placed in a user-friendly What-You-See-Is-What-You-Get (WYSIWYG) Editor.

Pages are checked out to only one user at a time to prevent users from overwriting each other’s work, but as the pages move through the workflow system, the system automatically changes to whom the page is checked out based on its placement in the workflow system. When creating new pages, preconfigured templates are made available to provide consistency in web page design. Users may also have the ability to upload new images, add words to the OU Campus dictionary, access full page source, and much more.

When using the DirectEdit login method, the Pages view shows the available editable regions. Once a region is chosen for editing, the WYSIWYG editor toolbar is shown. In expanded view it shows the files and subdirectories for a directory and the Page Actions toolbar. The page actions include a comprehensive set of functions that can be performed on any page. Available functions are dependent upon authority level.

For more information, visit the Login page.

The Content menu is the most frequently used menu within OU Campus. It provides access to the primary functions for editing pages. Most users will have the Pages, Assets, Recent Saves, and Recent Publishes areas available to them, but the functionality under Content depends upon user level.

For more information, visit the Content page.

When navigating through the system either by breadcrumb links, the File Navigation sidebar, or via Content > Pages, content within a directory is shown in the Pages list view. Hovering over content in the view, or checking out content and hovering reveals more commands on menus. Many of these are also found in the actions view toolbar that is available with preview/edit mode.

For more information, visit the Pages and Page Actions pages.

There are several types of editors available to edit pages in distinctly different ways, but the WYSIWYG Editor is the most common way for users to edit pages in OU Campus. The WYSIWYG Editor allows for a familiar experience of editing a page similar to that of many web applications and traditional word processors.

For more information, visit the WYSIWYG Editor page.

For a broader understanding of using the system, there are several topics regarding functionality that is available throughout the system.

For more information, visit the Common Functionality page.
Log In

Overview

End-users and administrators alike can log in to OU Campus through a published page with the use of an on-page link known as DirectEdit™. DirectEdit can be a link, a button, an image, and more anywhere on a published page, as it can be styled to match the look and feel of the site. Typically, every page of a web site managed by OU Campus includes a DirectEdit link to allow users to log in directly to edit a page.

After clicking the DirectEdit link, users are logged in directly to the Edit view of the page they logged into. Users must have the proper access privileges granted in order to access the page. Without proper access, users will be logged into OU Campus, but will be unable to view the page they logged into via DirectEdit.

The DirectEdit button type is configurable for the site by a Level 10 administrator. At the account level, the Login Page settings can be used to configure log in, log out, and authentication pages.

The layout that is viewed upon logging in to OU Campus depends upon the access settings for that particular editable region.

About DirectEdit

Users can access the OU Campus interface using DirectEdit by navigating to the page to be edited and clicking the DirectEdit link. DirectEdit links are determined by the template design. For example, the demo site, Gallena University, uses the Last Updated date found in the footer of the web pages as the DirectEdit link.

Each implementation will be different, however. If a user is unsure as to what the DirectEdit link is for their site, they should contact a site administrator.

Clicking the link will take the user to the OU Campus login page. Once logged in, the browser session is persistent and a user can open another page in the same browser without having to log in again.

Editing a Page with DirectEdit

1. Click the DirectEdit link on the published page. If a user does not know what has been specified for their institution, they should contact their administrator.

2. Use the login credentials that have been provided for the user by the administrator. This might be a user name and password that is specific to OU Campus, or it may be that another authentication method is being used, such as LDAP, CAS, or Shibboleth.
3. Select an editable region. For more information on editable regions, visit the Editable Regions page.
4. Edit the page.
5. Save and publish the page (or send to an approver).

Log out

Users can log out of OU Campus via the global navigation bar.

1. Hover over the user’s name.
2. Choose Logout from the menu.
3. The original Login screen will be shown unless otherwise configured by an administrator.

Reset Password

End-users and administrators alike can create a new password for their account. Reset Password allows users to change their password by entering their username and email address in a modal. After the information has been provided, an email is sent to the user, containing directions and a link that users can use to reset their password on their own without having to contact a system administrator.

Note: If a user’s password is managed by an external authentication method, such as CAS or LDAP, the user will have to contact a system administrator for a password reset, as passwords are not stored within OU Campus in these cases.

1. From the main Login screen, choose Reset Password.
2. A modal will appear, prompting the user to enter their username and email address associated with their username. Once both text fields have been entered, clicking Submit will send the email to the user's email inbox. If the operation needs to be cancelled, simply choose Cancel.

3. After a user has submitted their request, the system notifies them that it has sent an email to their inbox with instructions and a link to reset their password.
Failed Logins and User Lockouts

If a user incorrectly enters their login credentials too many times in a row (the number can be configured by Level 10 administrators), then they will automatically be locked out of the OU Campus system. This will prevent users from trying to log in again. In the event of a user lockout, the Reset Password function becomes unavailable and an email is sent to the user notifying them of the lockout. An administrator must reset the user’s login privileges.
Checked Out/In

Overview

The checked out/in icon, represented by a lightbulb, reflects the state of an OU Campus page or file. When a user edits a page by clicking on an editable region button, or clicks to a  from a list view, the page is automatically checked out to that user. Likewise, when the user publishes a page it is automatically checked back in.

When a page or file is checked out to a user, no other users can enter the pages and make changes until the file has been checked back in. A level 10 administrator can override this and manually check pages back in that are checked out, and doing so will cancel any unsaved changes to the page.

A user might also decide to check out a page in order to make other page options available. OU Campus also has status indicators help make clear why a page is not available for editing as well as who has checked out a page, scheduled an action, or if the page is in the process of a workflow. These icons are shown on many of the screens that display content lists, most notably the File Navigation sidebar, Pages list view and the My Checked-Out Content gadget.

For example, in the Pages list view (Content > Pages), the page status indicators are found in the Status column. A lit light bulb indicates a page is checked out to the currently logged in user and a red lock indicated the page is checked out to another user. An unlit light bulb indicates the file is checked in and available to be checked out.

Page Status Indicators in File Navigation Sidebar

```
<table>
<thead>
<tr>
<th>Pages</th>
<th>Assets</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>_resources</td>
</tr>
<tr>
<td></td>
<td>_sidenav.inc</td>
</tr>
<tr>
<td></td>
<td>about</td>
</tr>
<tr>
<td></td>
<td>academics</td>
</tr>
<tr>
<td></td>
<td>_sidenav.inc</td>
</tr>
<tr>
<td></td>
<td>final-exam-schedule.pcf</td>
</tr>
<tr>
<td></td>
<td>index.pcf</td>
</tr>
<tr>
<td></td>
<td>library.pcf</td>
</tr>
<tr>
<td></td>
<td>study-abroad.pcf</td>
</tr>
<tr>
<td></td>
<td>admissions</td>
</tr>
</tbody>
</table>
```
Checked-Out Pages in Gadgets Sidebar

Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Light Bulb" /></td>
<td>An unlit light bulb indicates that the page is checked in and can be checked out for editing by any user with the proper permissions.</td>
</tr>
<tr>
<td><img src="image" alt="Light Bulb" /></td>
<td>A lit light bulb indicates that the page is checked out to the current user (the individual currently logged into OU Campus).</td>
</tr>
<tr>
<td><img src="image" alt="Lock" /></td>
<td>A red lock indicates that the page is checked out to another user. Users can hover over the lock to see who has checked out the page.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar" /></td>
<td>A green calendar icon is the status indicator for a publish scheduled by the current user. Administrators or the individual who scheduled the page to be published can click on the icon to change the publish date and time or cancel the publish completely.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar" /></td>
<td>A red calendar icon is the status indicator for a publish scheduled by another user. Administrators or the individual who scheduled the page to be published can click on the icon to change the publish date and time or cancel the publish completely.</td>
</tr>
</tbody>
</table>
Icon | Description
--- | ---
|  | the publish date and time or cancel the publish completely.

A red circle with a line through it is the status indicator for an expire scheduled by the current user or another user. A scheduled expire can be removed or rescheduled by the user who scheduled the expire. An administrator can check in the page, which effectively cancels the scheduled expiration. This icon is displayed to all users, not just the user who scheduled the expiration.

**Checking In a Page**

It is valuable to note that pages stay checked out to the user until the user:

- Sends the page to another user for review.
- Publishes the page.
- Checks the page back into the system by clicking on the lit (yellow) light bulb.

**Behaviors of Checked Out Pages**

If a page is checked out by another user, the current user may still perform the following actions; even though the page is locked:

- Edit access settings
- Edit reminders
- Preview the page
- View the log
- Copy the file

**Available Actions for a Locked Page**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Date/Time</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>resources.pcf</td>
<td>3.3K</td>
<td>10/21/2014 10:21 AM</td>
<td>Edit, Review, File</td>
</tr>
<tr>
<td>whygu.pcf</td>
<td>3.6K</td>
<td>9/9/2014 10:08 AM</td>
<td>Preview, Log</td>
</tr>
</tbody>
</table>

**Best Practices**

- Make sure to check the page back in when finished editing the page so it can be made available to other users.
- OU Campus supports WebDAV and can be enabled by a Level 10 administrator. When WebDAV is enabled, OU Campus supports file locking with specific WebDAV clients that utilize file locking.
Drag and Drop

Overview

OU Campus includes the ability to drag and drop content including pages, files, and directories. Users may drag and drop objects from one location to another within the interface, or they may drag objects from their local computer into OU Campus.

This is especially useful for quickly uploading files from a local computer to a server or moving content within OU Campus. Users can utilize the drag and drop functionality of the interface to move, upload, and insert content using what are referred to as "drop zones."

In addition to image file types, files with extensions of .html, .js, .txt, .xsl, .exe, .asp, .php, and .pcf may also be dragged to the Pages list view.

The Drop Zone

The drop zone refers to the area within OU Campus where a file or directory can be dropped when dragging to the interface.

When dragging files into or within OU Campus, the content area will be outlined in green or the content row will be highlighted in green to indicate where the dragged file will be placed. When dragging files from the local computer into OU Campus in order to upload them, a blue alert at the bottom of the screen will also appear to indicate where the file will be uploaded.

The example below shows the green outline in the content area of OU Campus, the green highlighted rows (which are folders into which content can be moved/uploaded), and the blue alert at the bottom of the screen.

Dragging content in to a page being edited with the Source Editor results in the dragged content being placed inline in the source code and highlighted.
Moving Content with Drag and Drop

Drag and drop functionality can be used to move files from one location to another within an OU Campus site. When Dependency Manager is on, content moved on the staging server, including directories, are silently republished to the production target and the links are updated automatically, unless the content is locked with an action that would otherwise prevent auto-publishing such as a scheduled expire. Moving content on the production server, including directories, will not be reflected on the staging server.

Content can be moved using drag and drop within and between the Pages list view and the File Navigation sidebar. Content can also be moved from the Gadgets sidebar into a directory in the Pages list view.

When moving files within OU Campus, a file with the same name cannot be overwritten; for example, moving an indexpcf file from one directory to another that already has an indexpcf file would result in an error notification and no files being moved.

Users can move files either individually or in bulk using drag and drop. To move files using drag and drop:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar. Alternatively, expand the File Navigation sidebar and navigate to the file using that method.
2. Once the file has been selected, drag the content to its new destination.
3. To move multiple files, select the checkbox next to each target item in the Pages list view and then drag the content to the new destination folder. The icon displays a number, indicating the number of files being moved. **Note:** Multiple files cannot be selected from the File Navigation sidebar.
Uploading Content with Drag and Drop

When Binary Management is not enabled, binary files uploaded through staging are either uploaded directly to the production server or the default publish target. With Binary Management enabled, binary files can be uploaded directly to staging.

Files can either be dragged and dropped directly into the Pages list view to upload them to the currently-shown directory, or they can be dragged into the **Upload** modal to add them to the upload queue, instead of browsing for them in a filechooser.
Content uploaded to staging must be published or copied to production to be available on the web server. When dragging content that will take a lengthy amount of time to complete, users can continue to navigate around the CMS and a notification will show on the bottom of the screen upon the completion of the action.

For more information on uploading content, refer to the Upload page.

Inserting Content with Drag and Drop

When a user is in the WYSIWYG Editor or the Source Editor, they are also able to utilize drag and drop to insert content directly onto the page. Content can be inserted in the WYSIWYG Editor using the Images gadget. To insert images with the Images gadget:

1. Ensure that the Images gadget is enabled by expanding the Gadgets sidebar and clicking Choose Gadgets (gear icon). Select Images from the dialog and click Save.
2. Navigate to the page to be edited and open an editable region to display the WYSIWYG Editor.
3. Expand the Images gadget in the Gadgets sidebar to display the available images.
4. Drag and drop the image into the WYSIWYG Editor.
The mission of the Library organization is to connect students, faculty, staff, and members of the local community with the information resources they need for study, research, and recreation. The library contains substantial collections of books, journals, government documents, videos, maps, and other physical materials, all listed in its online catalog.

The Library organization provides a wide range of library instruction opportunities to the campus community. For many students the first introduction to library services at GU is through the required library component of University 100, designed to introduce new students to basic concepts of information literacy. Librarians also provide a variety of workshops, as well as individual in-depth consultation focusing on a specific research topic.

The Library provides adaptive devices to make our print and electronic resources accessible to the disabled and works closely with Disabled Student Services to ensure that equipment, facilities, and collections are responsive to special needs.

For more information about the GU Library, please contact the Campus Librarian at library@gallenauniversity.com.
WYSIWYG Editor

Overview

There are several types of editors available to edit pages in distinctly different ways, but the WYSIWYG editor is the most common way for users to edit pages in OU Campus. The WYSIWYG (What You See Is What You Get) Editor allows for a familiar experience of editing a page similar to that of many web applications and traditional word processors.

Currently, OU Campus contains two WYSIWYG Editors: JustEdit and the "old" WYSIWYG Editor. JustEdit is based off of an updated version of TinyMCE, and allows for more accurate in-context editing compared to the standard WYSIWYG Editor. Both editors function very similarly.

When logging into the system to directly edit a page, there may be several editable regions available. The available editable regions are defined by permissions levels and group associations. Only areas that are available to be edited by that user are shown with an Edit button. Clicking on the Edit button above a region allows for the area to be edited. Depending on whether JustEdit or the WYSIWYG Editor is enabled for that user, the respective editor will open and the assigned toolbar will appear.

With JustEdit, users are able to make changes to an editable region while seeing how the content will appear on the page. This is called in-context editing. Once the edits have been made and saved, the fully-configured page can be seen using Preview mode in the Page Actions toolbar.

When using the standard WYSIWYG Editor, the template design may include an image in the background that helps give the appearance of in-context editing, though the image is only a sample background.
and not the actual page. In the same manner as JustEdit, the fully-configured page can be seen using Preview. Note: If JustEdit is the main WYSIWYG editor, this background image may not be configured for the site.

When editing in the WYSIWYG, modifications should be saved by clicking the Save icon before navigating away from the page. If an attempt is made to navigate away from the page without first saving it, the user is shown a reminder to save the page.

Toolbars and Tools

Many of the editing tasks for a page, such as inserting images and links, applying formatting such as bold or italics, and spellchecking a page, can be accomplished from within the WYSIWYG using the toolbar. WYSIWYG toolbars are customizable and the toolbar the user sees may contain a subset of the available tools, as administrators can create custom toolbars and assign them to users, sites, directories, pages, and editable regions.

While the JustEdit Toolbar and standard WYSIWYG Toolbar look different, the functionality is the same for the icons available in both toolbars. Some toolbar functions in the old toolbar are not present or have been condensed in the JustEdit toolbar.

JustEdit Toolbar
Old WYSIWYG Toolbar

Icons represent the tools. Clicking on any icon performs an action, either directly to the page, or to the selected text and graphics. Some icons display more options in a drop-down menu or dialog.

The availability of a function is based on the selected items or the location of the cursor on the page. For example, if nothing is selected, functions such as **Insert Link** are dimmed, signifying that this function is not available at the moment. For the **Insert Link** function button to be available, the user must first select text or a graphic.

In many cases, right-clicking offers contextual functions. For example, right-clicking within a table provides a list of available table editing and formatting functions. Additionally, commonly used keyboard shortcuts are available within both editors.

**Toolbar Functionality**

The JustEdit toolbar is organized into two rows, and the standard WYSIWYG toolbar is organized into three rows. Each row has groups of icons that correspond to similar functions. These groups are divided by a vertical line in the toolbar. The behavior of the icon is specific to the functionality of the tool. For example, some tools (such as **Insert/Edit Link**) require text or another type of content to be selected before they are available on the toolbar. Other items on the toolbar include icons that are unavailable until the main feature has been inserted on a page. For example, the **Insert/Edit Table** icon will be available, but the other table editing tools, such as those to define row properties or delete a column, are not available until a table has been inserted on a page. Some items such as the **Insert/Edit Image** icon or **Spell Check**, when clicked, provide a modal that contains a lot of advanced functionality. One last type of element that might be available on the toolbar are several drop-down selectors that provide the ability to style text.

One item that is not represented on the toolbar, but is available from within the WYSIWYG, is the ability to save-in-place (**CTRL+S** or **CMD+S**). This offers users the ability to save the page without clicking the usual save icon that ends the editing session. Save-in-place saves the page and allows the user to continue editing.
Overview
The toolbar of the WYSIWYG editor provides much the same functionality as a standard word processor, as well as some additional web development and OU Campus-specific options.

The Classic Editor and JustEdit toolbars are almost identical in terms of functionality.

Classic Editor

![Classic Editor Toolbar]

JustEdit

![JustEdit Toolbar]

Toolbar Row 1
Most of the tools available on the first row of a toolbar for the WYSIWYG are basic text formatting and linking. The descriptions of the functionality available for each tool is provided on this page. A few of the features have a more in-depth description; links are provided to those pages.

- File Tools
- Cut, Copy, Paste, Find, Replace
- Undo/Redo
- Spell Check
- Remove Formatting
- Font Formatting
- List, Indents
- Text Placement (Vertical)
- Align, Justify (Horizontal)
- Link Tools, WYSIWYG Help Documentation

Toolbar Row 2
A brief description of the functionality available with each tool on row 2 of the toolbar is provided in the tables below. Several of the features require a more in-depth description and links to those pages are provided also. Content on this page includes:

- Font Properties (Family, Size, Format, Styles)
- Text Color, Text Background
- Images/Media
- Miscellaneous Functionality

Toolbar Row 3
The third toolbar is available only in the Classic Editor. It contains two functions, tables and forms. In JustEdit tables are available in Row 2 under Miscellaneous Functionality, and forms have been phased out in favor of LDP Forms.
In Classic Editor for tables and forms, the additional features are available after the initial table or form has been inserted on the page. Place the cursor within the element and the editing tools will become available.

- Tables
- Forms

**File Tools (Save, Save As, Revert, Restore)**

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Save</td>
<td>Click to save the current file on the staging server and exit the WYSIWYG Editor. Remember, it will not be live on the production server until it is published. To use save-in-place, use the keyboard shortcut CTRL+S for Windows or CMD+S for Mac.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save As</td>
<td>Click to save the current file with a new file name and exit the WYSIWYG Editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Revert to Last Saved</td>
<td>Click to undo all changes and revert the content in the editable region to its original state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exit Without Saving</td>
<td>Click to exit the editable region without saving your changes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Auto Draft</td>
<td>Click to restore the content to its last auto-saved point. For more information, visit the Auto Draft page.</td>
</tr>
</tbody>
</table>

**Cut, Copy, Paste, Find, Replace**

Many browsers (specifically Firefox, Chrome, and Safari) disable the use of the cut, copy, and paste commands via the WYSIWYG toolbar for security purposes. This is not a function of OU Campus; this is a browser behavior. The alternative workaround is to use keyboard shortcuts.
<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="cut.png" alt="Cut Icon" /></td>
<td><img src="cut.png" alt="Cut Icon" /></td>
<td>Cut</td>
<td>To remove content from the document in order to move it somewhere else, highlight the content and click the icon. The keyboard shortcut is CTRL+X for Windows or CMD-X for Mac.</td>
</tr>
<tr>
<td><img src="copy.png" alt="Copy Icon" /></td>
<td><img src="copy.png" alt="Copy Icon" /></td>
<td>Copy</td>
<td>To copy a content from the page, highlight the content and click the icon. The keyboard shortcut is CTRL+C for Windows or CMD-C for Mac.</td>
</tr>
<tr>
<td><img src="paste.png" alt="Paste Icon" /></td>
<td><img src="paste.png" alt="Paste Icon" /></td>
<td>Paste</td>
<td>To paste content on to a page, click the location the content should be placed on the page and click the icon. The keyboard shortcut is CTRL+V for Windows or CMD-V for Mac. This pastes only valid content, code, and styling. The paste automatically switches between a traditional paste (e.g., pasting the code when text is copied from a page in a web browser), and pasting from Word, where it removes any MSO formatting that is not appropriate for a web site. The Paste function always cleans up the content to be pasted to remove any formatting or code that is not compliant with the requirements of the WYSIWYG Editor.</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Paste as Plain Text</td>
<td>Clicking the icon keeps it selected until clicked again, and all pastes going forward until exiting the WYSIWYG Editor will be plain text. This removes all formatting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Find</td>
<td>Click to search for text on the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Find/Replace</td>
<td>Click to search for text on the current page and then replace that text with other text.</td>
</tr>
</tbody>
</table>

**Undo Redo Functions**

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Undo</td>
<td>Click to undo the last changes made in this session one by one.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redo</td>
<td>Click to redo changes that were previously undone and should be restored.</td>
</tr>
</tbody>
</table>

**Spell Check**

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
|              |               | Toggle Spell Checker  | Click to spell check the region that is being edited. Misspelled words are underlined with a red, squiggly line. Change the incorrectly spelled word with the suggested words provided or choose one of the other options provided:

- Ignore the incorrectly spelled word (e.g., not make any changes to it). |
### Add to the Dictionary

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Add to the word to the dictionary: Level 9 and 10 administrators can add marked words to a site-wide dictionary, and administrators can give users Levels 1 through Level 9 the ability to add words to the dictionary as well.</td>
</tr>
</tbody>
</table>

In JustEdit, the drop-down menu on this icon lists the available languages for which to run the spellcheck.

For more information about adding words to the custom dictionary, visit the [Custom Dictionaries page](#).

### Remove Formatting

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Remove Formatting</td>
<td>To remove all formatting for a selection, highlight the text to be updated and click the icon. This returns the selected text back to the default settings.</td>
</tr>
</tbody>
</table>

### Font Formatting

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>B</td>
<td>Bold</td>
<td>Applies bold formatting to selected text.</td>
</tr>
<tr>
<td>I</td>
<td>I</td>
<td>Italic</td>
<td>Applies <em>italicized formatting</em> to selected text.</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>📝</td>
<td>📝</td>
<td>Underline</td>
<td>Applies underlined formatting to selected text. Please note that underlined text often means that a word or phrase is a link to another web page. In this case, however, the underline formatting does not create a link (to create a link, click Insert/Edit Link).</td>
</tr>
<tr>
<td>ABC</td>
<td>S</td>
<td>Strikethrough</td>
<td>Applies strikethrough formatting to selected text.</td>
</tr>
</tbody>
</table>

**Lists, Indents**

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ☐            | ☐             | Unordered list | Turns the selected text into an bulleted list. Example:  
  • Apples  
  • Oranges  
  • Bananas |
| ☐            | ☐             | Ordered list | Turns the selected text into a numbered list. Example:  
  1. Click the Go button.  
  2. Enter the text to search on.  
  3. Click Start. |
| 👇           | 👇            | Decrease Indent | Decreases the indent of a paragraph. Each consecutive click moves text further to the left. |
### Classic Icon | JustEdit Icon | Tool | Description
--- | --- | --- | ---
| | | Increase Indent | Increases the indent of a paragraph. Each consecutive click moves text further to the right. |
| | | Blockquote | Blockquote is a block-level element in HTML that can be used to set-off quotations or to cite material. |

### Text Placement (Vertical)

| Classic Icon | JustEdit Icon | Tool | Description |
--- | --- | --- | --- |
| | | Superscript | Formats the selected text as superscript text. |
| | | Subscript | Formats the selected text as subscript text. |

### Align, Justify (Horizontal)

| Classic Icon | JustEdit Icon | Tool | Description |
--- | --- | --- | --- |
| | | Align Left | Aligns a block-level element such as a paragraph or a heading to the left margin. |
| | | Align Center | Center aligns a block-level element such as a paragraph or a heading within the left and right margin. |
| | | Align Right | Aligns a block-level element such as a paragraph or a heading to the right margin. |
| | | Align Full | Justifies text making it flush on both the left and right side. |
## Link Tools, WYSIWYG Help Documentation

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>🔗</td>
<td>Insert/Edit Link</td>
<td>To create a hyperlink:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Select the text or image for the link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the Insert/Edit Link icon. If applicable, the modal contains existing link information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the Browse icon to select an internal page to which to link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. After locating the file, click Select Link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Insert.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For links to pages internally, a page should generally be chosen from a production server, publish target, or an auxiliary server. An unpublished file on the staging server or publish target can also be chosen by choosing the staging server or publish target from the drop-down, navigating to the file, and selecting the HTML version that is available. Links can also be made across sites within an account with the file browser by clicking Sites in the breadcrumb and choosing the appropriate site. If Dependency Manager has been enabled for the account,</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>-----</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>dependency tags instead of URLs are inserted into the source of the page when inserting a link. For links external to the site, the complete URL for the resource can be typed (or pasted) into the URL field. Optionally, a target window type and an anchor name can also be entered. For more information about links and linking, visit the Insert/Edit Link page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Create or Modify a Mailto Link To create a mailto link, select the text or image for the link, then click the icon. If applicable, the resulting modal contains existing mailto information. Properties for the mailto link can be defined including the email address that is provided when the link is clicked. For more information, visit the Mailto Link page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Unlink/Remove Link Click within the hyperlink and click the Unlink icon to remove a hyperlink. Note: For unlinking anchors, the Unlink icon works with anchors in Internet Explorer. It will not work</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| ![Classic Icon](image1) | ![JustEdit Icon](image2) | Insert/Edit Anchor | To create an anchor:  
1. Position the cursor where the anchor should be placed or select the text or image.  
2. Click the Insert/Edit Anchor icon.  
3. In the Anchor Name field, enter the name for the anchor. It is not necessary to enter a # (hash tag).  
4. Click Insert.  
To modify an existing anchor:  
1. Click the existing anchor shown in the editing area.  
2. Click the Anchor icon on the toolbar.  
3. The Insert/Edit Anchor modal shows the existing text for the anchor.  
4. Make the modification to the text and click Update.  
The specifics of valid anchor names can be found in the HTML 4.01 and HTML 5 pages. |
| ![Help Icon](image3) | ![Help Icon](image4) | Help Icon         | The Help icon displays the help text for the WYSIWYG Editor. It shows help text for all available functions, not only those limited to the toolbar being used. |
# Font Properties (Family, Size, Format, Styles)

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Font family](image) | ![Font Family](image) | Font Family | This Font Family drop-down displays a list of the standard fonts recognized by most web browsers. To change the font of existing text, select the text and choose a font from the drop-down list. To start typing new text with a specific font, position the cursor where text should be inserted and select a font from the drop-down list, then begin typing. Text can also be selected and the formatting applied. Note that the appearance in the WYSIWYG Editor may not reflect the newly applied styling. From the drop-down deselect the font size to stop applying it in the WYSIWYG by clicking on it again. The markup is added as a span, i.e.:

<span style="font-family: 'book antiqua', palatino;">on the bright plume</span> |

<p>| <img src="image" alt="Font size" /> | <img src="image" alt="Font Sizes" /> | Font Size | This Font Size drop-down changes the size of selected text. Font size properties are configured by an administrator and labeled 1 through 7. To start typing new text with a specific |</p>
<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>font size, position the cursor where text is to be inserted, select a size from the drop-down list, then begin typing. From the drop-down deselect the font size to stop applying it in the WYSIWYG by clicking on it again. The markup is added as a span, i.e.: &lt;span style=&quot;font-size: x-large;&quot;&gt;This is a font size application.&lt;/span&gt;</td>
</tr>
<tr>
<td>Format</td>
<td>Formats</td>
<td>Format</td>
<td>The Format drop-down lists built-in styles that can be applied to a selected paragraph. To apply an element from the Format drop-down, click within the paragraph (or select text), and then click the element from the drop-down. For more information, visit the Format Drop-Down page.</td>
</tr>
<tr>
<td>Styles</td>
<td>Styles</td>
<td>Styles</td>
<td>This drop-down sets the style of any selected text. The styles available are configured by the system administrator. Note that when applying a class from a Styles drop-down and then selecting another class from the Styles drop-down, both styles are applied to the text, i.e.:</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select Text Color</td>
<td>The color for selected text may be selected by using a picker, using a hexadecimal, chosen from a palette, or by color name. Alternatively, if a custom color has already been selected, click the icon to apply the text color. There are 216 color choices on the palette. To start typing new text with a specific font color, position the cursor at the location where new text is to be inserted, choose a color, and then begin typing. To color existing text, highlight the text to be colored and choose the desired hue.</td>
</tr>
<tr>
<td><img src="image" alt="Text Color" /></td>
<td><img src="image" alt="Select Text Color" /></td>
<td>Select Background Color</td>
<td>The color for the background of the selected text may be selected in the same way that text color is selected. To start typing new text with a specific background color, click the cursor at the location where new text is to be inserted, choose a color, and then begin typing. To</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Insert/Edit Image</strong></td>
<td>color the background of existing text, highlight the text to have its background colored and choose the desired hue.</td>
</tr>
</tbody>
</table>

**Images/Media**

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image Icon" /></td>
<td><img src="image.png" alt="Image Icon" /></td>
<td><strong>Insert/Edit Image</strong></td>
<td>The Insert/Edit Image tool provides the functionality for linking to an image by browsing or by uploading, and allows for access to the Image Editor. Additional tabs and fields provide advanced options for images such as including styling and JavaScript. It also includes a preview. For more information, visit the Image Editor and Insert/Edit Image pages.</td>
</tr>
<tr>
<td><img src="media.png" alt="Media Icon" /></td>
<td><img src="media.png" alt="Media Icon" /></td>
<td><strong>Insert/Edit Embedded Media/Video</strong></td>
<td>The Insert/Edit Embedded Media tool provides the functionality for embedding media specific to several format types to an image by browsing or by uploading. Additional tabs and fields provide advanced options for embedded media such as specifying dimensions, setting audio quality options and Flash options, and previewing the source. For more information, visit the</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Insert/Edit Embedded Media page.</td>
</tr>
</tbody>
</table>

### Miscellaneous Functionality

<table>
<thead>
<tr>
<th>Classic Icon</th>
<th>JustEdit Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Insert Horizontal Line</td>
<td>Adds a horizontal rule. <code>&lt;hr /&gt;</code></td>
</tr>
<tr>
<td>BR</td>
<td></td>
<td>Insert line break</td>
<td>To insert a line break, click the Line break icon. This is the same as entering <code>&lt;br /&gt;</code> into the source.</td>
</tr>
<tr>
<td>©</td>
<td></td>
<td>Insert Special Character</td>
<td>To insert a special character such as an copyright symbol, registered trademark, or other symbol, click the Insert Special Character icon. The Select Special Character modal provides a selection of 200 special character from which to choose. Hover or use left and right keyboard arrows to navigate the selection. During the selection process, a preview of the character is shown with its name, HTML character reference, and numerical character entity reference. Click on the icon of the character to insert into the page. Right click the symbol and choose Copy Link from the shortcut menu to copy it</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Classic Icon" /></td>
<td><img src="image2.png" alt="JustEdit Icon" /></td>
<td><img src="image3.png" alt="Tool" /></td>
<td>to the clipboard, which allows the symbol to be repeatedly pasted on a page.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Cleanup Messy Code" /></td>
<td></td>
<td><img src="image5.png" alt="Cleanup Messy Code" /></td>
<td>The Cleanup Messy Code icon removes extraneous tags and adds appropriate ending tags where necessary. This helps with cross-browser functionality as well as being a best practice.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Show/Hide Block Elements" /></td>
<td></td>
<td><img src="image7.png" alt="Show/Hide Block Elements" /></td>
<td>Toggles the WYSIWYG view to show or hide block-level element labeling. Each element such as <code>&lt;p&gt;</code> or <code>&lt;article&gt;</code> is displayed encapsulated with a thin border and labeled with a small tag. For more information, visit the Show/Hide Block Elements page.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Show/Hide Guidelines/Invisible Elements" /></td>
<td></td>
<td><img src="image9.png" alt="Show/Hide Guidelines/Invisible Elements" /></td>
<td>The Toggle Guidelines/Invisible Elements icon adds/removes the outlines of tables and other elements, for visual purposes only.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Edit HTML Source/Source Code" /></td>
<td></td>
<td><img src="image11.png" alt="Edit HTML Source/Source Code" /></td>
<td>The Edit HTML Source icon opens a code view</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of the HTML source. If a user has been granted access, there is also an HTML Source Editor available for the source code editing. For more information, visit the <a href="#">HTML Source Editor</a> page.</td>
</tr>
<tr>
<td><img src="image" alt="CodeProtect" /></td>
<td>Not available in JustEdit</td>
<td>CodeProtect</td>
<td>Displays the position of server-side code within the WYSIWYG Editor represented within the editing area with the PHP Symbols icon: <img src="image" alt="PHP Symbols" /> This allows for easy editing of server side code (PHP only). For more information, visit the <a href="#">CodeProtect</a> page.</td>
</tr>
<tr>
<td><img src="image" alt="Snippets" /></td>
<td><img src="image" alt="Snippets" /></td>
<td>Snippets</td>
<td>Click the Snippets icon in order to select preexisting snippets of HTML or text to be inserted into the page. The Snippets available are set by the system administrator. For more information, visit the <a href="#">Snippets</a> page.</td>
</tr>
<tr>
<td><img src="image" alt="Assets" /></td>
<td><img src="image" alt="Assets" /></td>
<td>Assets</td>
<td>Click the Assets icon to select a preconfigured asset to insert into the page. For more information, visit the <a href="#">Assets</a> page.</td>
</tr>
<tr>
<td>Not available in Classic Editor</td>
<td></td>
<td>Components</td>
<td>Click the Components icon to select a component to fill out</td>
</tr>
<tr>
<td>Classic Icon</td>
<td>JustEdit Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Table</td>
<td>This icon will bring up a drop-down menu where all table properties are now found, from inserting a new table to merging cells and editing properties. To insert a new table, hover over <strong>Insert Table</strong> and then use the mouse to hover over the correct amount of rows and columns. Clicking will create the table. For more information, visit the <strong>Tables</strong> page.</td>
</tr>
<tr>
<td>Found on Toolbar Row 3</td>
<td><img src="image" alt="Icon" /></td>
<td>Maximize Content Region</td>
<td>This icon, when clicked, will expand the JustEdit editable region to fill the width of the frame window. This is particularly useful when editing table transformations, where the table is extremely wide in the Editor but the transformed content fits more nicely into the editable region on the page.</td>
</tr>
</tbody>
</table>

**Table Tools (Classic Only)**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Insert/Edit Table</td>
<td>To insert a table, position the cursor, then click the icon. The Insert/Edit Table modal includes</td>
</tr>
<tr>
<td>Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>several fields that can be used to define the table including:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Columns: Number of columns in table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rows: Number of rows in table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cell Padding: Padding around cells</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cell Spacing: Spacing between cells</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Alignment: The alignment of the content within the cells</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Border: Thickness of the border around the cells</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Width: Width of table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Height: Height of the table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Class: A class defining the styling of the table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Table Caption: Choose whether or not to have a caption above the table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fill in table details, then click OK to insert table, or click Cancel to return to the editor. For more information about tables, visit the Insert/Edit page.</td>
</tr>
<tr>
<td></td>
<td>Table Row Properties</td>
<td>Edits the alignment, background color and several other properties of the rows of the table.</td>
</tr>
<tr>
<td></td>
<td>Table Cell Properties</td>
<td>Edits the alignment, background color and several other properties of the cells of the table.</td>
</tr>
<tr>
<td></td>
<td>Insert Row Before</td>
<td>To insert a row above another row, click inside the row cell the new row is to precede, then click the icon.</td>
</tr>
<tr>
<td></td>
<td>Insert Row After</td>
<td>To insert a row below another row, click inside the row cell the new row is to follow, then click the icon.</td>
</tr>
<tr>
<td>Icon</td>
<td>Tool</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Delete Row</td>
<td>To delete a row, click inside the row to be removed, then click the icon.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Insert Column Before</td>
<td>To insert a column before another column, click inside the column cell the new column is to precede, then click the icon.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Insert Column After</td>
<td>To insert a column after another column, click inside the column cell the new column is to follow, then click the icon.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Delete Column</td>
<td>To delete a column, click inside the column to be removed, then click the icon.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Split Merged Table Cells</td>
<td>To split cells that have previously been merged, select the cell, then click the icon.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Merge Table Cells</td>
<td>To merge cells, highlight the cells to be merged, then click the icon.</td>
</tr>
</tbody>
</table>

**Form Tools (Classic Only)**

The Form tools build the client interface for the form. The site developer will need to provide the server side form processing code. The form tools available from within the Classic Editor are **not** the same as the Live Delivery Platform Forms.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Insert/Edit Form</td>
<td>Creates or edits the form. When creating a new form, set all attributes needed for the form to function properly.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Delete Form</td>
<td>Highlight the form for deletion and click the icon.</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Insert/Edit Input Element</td>
<td>Inserts or modifies input fields such as checkboxes, icons, or events.</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Insert/Edit Select Element</td>
<td>Inserts or modifies selection drop down elements.</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>Insert/Edit Textarea Element</td>
<td>Inserts or modifies textarea elements.</td>
</tr>
</tbody>
</table>

For more information, visit the **Forms** page.
WYSIWYG Spell Check

Overview

Within the OU Campus WYSIWYG Editor there is a built-in spell checker. Provided that this feature is available in the selected toolbar being used, utilizing the spell checker before publishing a page helps increase the professionalism and accuracy of the site. Currently the spell checker supports five languages, each with its own custom dictionary. The current languages supported are: English, Spanish, French, Italian, and Portuguese. These are the same custom dictionaries that are used during Page Check and/or Final Check. The WYSIWYG Spell Check feature checks the spelling only for the editable region that is open in the WYSIWYG. This differs from the Page Check/Final Check spell check, which performs the spell check on the complete page prior to being published.

Classic Editor

JustEdit

New and custom words can be added to the spell check dictionary on a per site basis. This is a useful tool for organizations with a set of custom words they do not want to appear marked as misspelled when using spell check in the WYSIWYG Editor. Custom words that have been added to a site’s dictionary are omitted by the spell checker tool in the WYSIWYG Editor for any page within that site. Keep in mind that it is possible that the spell checker in an individual’s browser may still mark the word as misspelled. If a word has been added to the dictionary, and it is still being marked as misspelled, check the browser’s spell check settings.

The default language is a configuration option, which allows various pages or users to be able to use by default different language options. The different custom dictionaries can be selected from the drop-down menu.
Once the WYSIWYG Spell Check is toggled on, misspelled words stay highlighted until an action is performed that corrects the issue. If new words are typed and misspelled, the spell check should be run again to catch more words.

**Correcting Misspelled Words**

1. Click the Spell Check icon from the WYSIWYG Editor toolbar. The default language will be used to spell check the page. However, if the page should be edited in another language click the downward facing arrow portion of the split button and select another language. Misspelled words are identified with a red underline.
2. Click on a word identified as misspelled. This displays a list of words that may be selected to replace the misspelled word and other options.
3. Select one of the suggested words to replace it. Other options are:
• Add to dictionary (if access has been granted)
• Ignore word: Allows just the current instance of the word to not be marked as misspelled
• Ignore all: Allows all current instance of the word to not be marked as misspelled

Note

: Keep in mind that the browser’s spell checker may be active and marking words as misspelled while the page is being edited. However, only OU Campus’ spell checker references the OU Campus custom dictionary. To help verify that a word is being marked as misspelled by the OU Campus dictionary, look to see if the spell check icon is highlighted. This indicates that the OU Campus spell checker is being used.

Adding Words

Adding custom words to the spell check dictionary is available dependent upon authority level. It is included automatically for Level 9 and 10 and it can be made available to Level 1 and above users by a Level 10 administrator.

1. Click the Spell Check icon from the WYSIWYG Editor toolbar.
2. Click the misspelled word that should be added.
3. From the shortcut menu, choose Add to dictionary.

When adding new words to the custom dictionary, they will get added to the dictionary of the language that is set for the spell checker tool. Unless set differently by an administrator, the default language is English. An additional custom dictionary may exist at the account level.

Browser Specific Spell Check vs. OU Campus Spell Check

In the WYSIWYG Editor, misspelled words can still appear underlined in red (indicating a misspelled word), even after they’ve been added to the dictionary. The reason for this is that many modern browsers have spell-as-you-type or automatic spell-checking capabilities built-in. This can lead to some confusion as to whether or not a word has in fact been added to the dictionary. To eliminate this problem, it can be helpful to turn off the browser’s spell-as-you-type functionality.

Refer to the specific browser help documentation on spell check for Firefox, Google Chrome, and Safari. Internet Explorer requires an add-on. Keep in mind that this is not all-inclusive of all available browsers, platforms, add-ons, or applications for spell checker options. Should the information needed not be listed in this help document, please see the help documentation for the browser, add-on, or application being used.
Insert/Edit Link

Overview

The Insert/Edit Link tool provides the basic functionality to add a hyperlink within the WYSIWYG Editor. Links are created by highlighting text or an image, clicking the **Insert/Edit Link** icon, and specifying the Link URL. The **Insert/Edit Link** icon is dimmed until the text or image to be hyperlinked is selected. A hyperlink can point to an internal web page, an external web page not maintained in OU Campus, or a directory or file within OU Campus or external to it. This can include linking to binaries, such as PDFs. In addition to providing the basic functionality for creating and maintaining links, this tool provides more advanced functionality such as linking to anchors, specifying targets, applying classes, and utilizing JavaScript and HTML to affect the style and behavior of a link.

Classic Editor

![Insert/Edit Link Icon]

JustEdit

![Insert/Edit Link Icon]

This page is divided into the following sections:

- Inserting a Link
- Links and Dependency Manager
- General Tab
- Advanced Tab
- Additional Options

Inserting an Internal Link

1. Within the **WYSIWYG Editor**, select the text or image for the link. In JustEdit, you can also insert a link into blank space, but unless you specify "Text to Display" the dependency tag will be displayed on the page.

2. From the toolbar, click the **Insert/Edit Link** tool.

3. The **Insert/Edit Link modal > General** or **Basic** tab is shown. If applicable, the modal contains existing link information.
4. Click the **Browse** icon to select an internal page to which to link.
5. The **Select File** modal is shown.

6. Select a file or directory to which to link. The staging server is selected by default and a PCF file type should be selected in order to have links managed. Navigation can be accomplished by:
   - Clicking the breadcrumb link to navigate up the folder structure
   - Filtering by entering characters of a subfolder or file name
   - Filtering by tags
   - **Uploading** a file and linking to it (Click the **Upload** button)
   - Selecting a different environment or auxiliary site

   Generally, for internal linking just select the PCF, click **Insert**, and see the next step.

7. From the **Select Product** modal, the HTML output is usually the default and highlighted, so click **Insert Link**.

8. In the **Title** field, it is frequently a best practice to add a short descriptive phrase.

9. From the **Insert/Edit Link** modal, click **Insert**.

Other configuration options for a link are also available before inserting the link; for example, selecting a target window/tab for the link to open in.
The title is important, as this is used by screen readers and helps keep the site in compliance with accessibility compliance standards. The text entered in this field is used to create the title attribute for the `<a>` element in HTML. A developer might use this attribute to display the text when mousing over the link. Here’s what it looks like in HTML:

```html
<a title="Contact Us" href="{{f:####}}">test</a>
```

### Linking to an External Page

The steps are the same as the procedure outlined above, but rather than browsing for the internal link, the complete URL for the resource can be typed (or pasted) into the URL field. Links to external pages are not tracked by Dependency Manager. The protocol prefix, i.e., `http://` or `https://`, is required.

### Linking to an Unpublished File

An unpublished file on the staging server or publish target can also be linked to, prior to actually publishing the page. The steps are nearly the same as the procedure outlined in the Inserting an Internal Link (Typical) heading up to and including linking to the HTML product. However, an important difference is that when publishing the file, there will be an Include Unpublished Dependencies checkbox and by default, it will be selected. This ensures that the unpublished file that was linked to is also published and proper link management is maintained.

- **Publish Options**
- ✔ Include Unpublished Dependencies

> This file contains links to items that have not been published.

> Select to publish these dependencies.

### Linking Across Sites within an Account

Links can also be made across sites within an account when inserting a link on a page within the WYSIWYG. The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical) heading, but rather than selecting from production select **Sites** in the breadcrumb, choose the appropriate site, and navigate to the desired file.

### Links and Dependency Manager

When **Dependency Manager** is activated, it is important to browse for the appropriate page (instead of typing or pasting in a URL) in order to ensure that the link will be updated. Pages can also be linked to internally without browsing by inserting a dependency tag, and can also be specified with a root-relative syntax.

Dependency Manager can be configured to manage links both within a site and across sites within an OU Campus account. However, it does not manage links to external websites. If Binary Management is in use for the site or sites, binary files such as PDFs and images are also managed.

Links with dependency tags may also be inserted with the Source Editor and file choosers and are supported across publish targets if Multi-Target Publish is configured. Once the appropriate page is selected, a dependency tag is shown instead of the page path. The actual path to which the link will be pointed is shown below the dependency tag.

Example syntax for the tags are shown as follows:

- `{d:####}` — Directory tag
- `{f:####}` — File/Page tag
Example of a Dependency Tag

Broken Links
When initiating a recycle action, the dialog provides a warning that any derivatives on the production server or publish target will be removed, as well as listing any files that contain links that will become broken.
If content is deleted anyway, a broken link is created. The system has various indications for broken links. Dependency Manager provides informative reporting for broken links and broken assets. When a dependency is lost, such as when a linked-to page or a subscribed-to asset is deleted, the dependency tag, path, and file name are shown within asterisks in the Insert/Edit Link modal. For example:

```
*** Broken f:1234 /training/about/filename.html***
```

One way to avoid broken links is to utilize the Include Unpublished Dependencies checkbox from the publish modal to publish any unpublished content. Dependency Manager reports at page publish time if there is dependent content that has not been published to the target server. This includes content that is linked or referred to by the page that is being published, as well as any unpublished assets. By selecting to include the unpublished dependencies, those unpublished files are published as well. This action prevents broken links (for example) from existing on the current page being published.

This checkbox is only shown if the Dependency Manager is being used on the site, dependency tags are used in the page being published, and one or more of those dependency tags refer to files that have not been published to the target yet.

For more information, visit the Dependency Manager page.

**General Tab**

The General Tab is the default tab opened when using the Insert/Edit Link tool. The General Properties include the basic options for inserting a link on a page within the WYSIWYG Editor.

**Link URL**

Used to specify to which page to link. For external web pages, enter the full URL, which should include the `http://` or `https://` prefix. For internal links, click the **Browse** icon to select the file. Dependency tags are automatically populated when Dependency Manager is active and an internal link is being inserted.

**Target**

Used to specify how the linked-to page is displayed. As a general rule, when inserting a link to another page on the institution’s website, the link should open in the same window. When inserting a link to a page
outside the institution’s website, or to a PDF, or other similar file, the page should open in a new window. This options for the Target field include:

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open in This Window/Frame or None</td>
<td>Linking to pages on the institution’s website</td>
</tr>
<tr>
<td>Open in New Window (_blank) or New Window</td>
<td>Linking to pages on another site or binary files</td>
</tr>
<tr>
<td>Open in a Parent Window/Frame (_parent)</td>
<td>Used with framesets</td>
</tr>
<tr>
<td>Open in Top Frame (Replaces All Frames) (_top)</td>
<td>Opens a page in the topmost parent frame</td>
</tr>
</tbody>
</table>

**Title**

The Title is both valuable and important as this is used by screen readers and helps keep the site in compliance with accessibility standards. The text entered in this field is used to create the title attribute for the `<a>` element in HTML. The title is an HTML attribute for the link and is often used to display a message while hovering over a link, which is also valuable for meeting accessibility standards. Here’s what it looks like in HTML:

```html
<a title="Contact Us" href="{{f:####}}">test</a>
```

**Class**

If a specific CSS class has been defined, this can be used to apply a class to the link. CSS can be defined for the site and for display in the WYSIWYG and the CSS and TXT files used for customization can be placed anywhere; however, typically, the site CSS is located in the `/resources/css` folder and the WYSIWYG CSS and TXT files are located in the `/resources/ou/editor` folder. The OU tags for the `<div>` and `<editor>` elements are located in the TMPL file.

For more information, visit the Customize the Styles Drop-Down page.

**Advanced Tab**

The Advanced tab provides additional configuration items for your links. This includes various HTML attributes that can be added to an `<a>` tag. The behavior of the attributes are contextual to HTML5 and to pre-HTML5/XHTML; that is, the validity and usage of an attribute may differ from one specification/recommendation to the next.
HTML5 and Pre-HTML5/XHTML

Note that some attributes included on this tab for the `<a>` tag link may be obsolete or deprecated for HTML5; for example, charset, which is no longer supported in HTML5, but is valid for pre-HTML5. Other attributes have changed scope as they have now become global attributes. By default in OU Campus, the HTML5 schema is not enabled as a site setting, this can be enabled by an administrator with caution. If the HTML5 schema is selected in the site setting, then the attributes that are no longer supported in HTML5 may not be available and/or may be removed from the markup by the WYSIWYG Editor.

Defining a Hyperlink

The value of the `href` attribute of an `<a>` tag is defined with the Link URL on the General tab when editing within the WYSIWYG Editor. The attributes on the Advanced tab are optional and many of the attributes require that the `href` attribute be defined. If the attribute values for the Advanced tab are defined via the tab fields or source code, the value is returned in the field. The Link URL can be manually specified, for example for an external resource, or the browse icon can be used to spawn a file chooser to add a link to an internal page or file, or to a page in another site within the account, and this ensures that the Dependency Manager is used to track and manage linking within OU Campus. The value of the `href` can even be script. For example:

The HTML5 specification makes a distinction between the terms `hyperlink` and `link`. A "link" to an external resource is used to "augment" the current content. For example, a link can be created with a `<link>` element to a stylesheet, but a hyperlink is exposed to the user for the express purpose of providing access to additional content. This distinction of diction is not typical within the OU Campus documentation as the terms are link and hyperlink are frequently used interchangeably. Link or linking is frequently used as a verb to express the concepts, actions, and code details involved with a hyperlink.
Many of the attributes provided on the Advanced tab require the href attribute also be defined within the <a> element and the specification also indicates that a hyperlink (as compared with a link) is created.

Here is an example of an <a href> construct with a few attributes included:

```
<a id="h-class-x" class="red" href="https://support.omniupdate.com/"
target="_blank">Link to Target Content</a>
```

The attributes that may be defined for the Advanced Properties include:

- ID
- Style
- Classes (Classic Only)
- Target Name (Classic Only)
- Language Direction (Classic Only)
- Target Language (Classic Only)
- Language Code (Classic Only)
- Target Character Encoding (Classic Only)
- Target MIME Type (Classic Only)
- Relationship Page to Target (Classic Only)
- Relationship Target to Page (Classic Only)
- TabIndex
- AccessKey (Classic Only)
- onclick (JustEdit Only)

**ID**

Specifies the value of the id attribute for the link. In previous incarnations of HTML, the name attribute on an <a> element was used to create an anchor and target it. For conformance with HTML5, the id attribute is preferred over the name attribute. For OU Campus pages the id should at least be unique to a page. The id attribute is flexible in implementation and can provide a specific target for an element, including for on-page linking within a document. An id can also be used as a target by scripts. Another usage of ids is to style an element with CSS, or to bookmark or footnote a document.

An id attribute:

- Is a global attribute in HTML5
- Must be a unique value relative to the "element's home subtree"
- Must contain at least one character
- Must not contain any space characters

The following example includes, firstly, a link to a footnote, and an id within its <a> element. The second example below is a caret character that links back to the text. This is how footnotes are accomplished on this page.

**Syntax**

```
<a id="hyperlink-comparison" href="index.html#f1">See footnote.[1]</a>
```

```
<a id="#f1" href="index.html#hyperlink-comparison">^</a>
```
Example of Bookmarks

An id can be used to link to a bookmark on a page. For example:

```html
<h1>Getting Around</h1>
<p>This topic includes information about how to get around campus.</p>
<h2>On this Page</h2>
<a href=#biking>Free Bike Usage</a>
<a href=#trolley>Free Campus Trolley</a>
<a href=#pods>Free Auto Pods</a>
<h2><a id=biking>Free Bike Usage</a></h2>
<p>Mountain bicycles are provided free of charge for on-campus usages. Try as you might they cannot be relocated off-campus as the embedded seashell prevents it.</p>
<h2><a id=pods>Free Auto Pods</a></h2>
<p>Auto pods with autonav can be used for longer off-campus journeys and require at least two travelers for distances greater than 3km roundtrip.</p>
```

Style

The style attribute can be used to apply inline CSS for the hyperlink. Several attributes from HTML 4 now apply to all elements as global attributes, the style attribute is one of them. It is not necessary to enter the quotation marks. For a markup like:

```html
<a style=color:red; background-color:#B2FF99; font-weight:800; word-spacing: 50px; href=https://support.omniupdate.com/>Funny Link Styling</a>
```

Enter the following in the field:

```
color:red; background-color:#B2FF99; font-weight:800; word-spacing: 50px;
```

Classes

Specifies one or more classes for the hyperlink that have been defined in CSS. The class attribute is considered global in HTML5 and can also be used to specify a microformat.

Syntax

```html
<a class=shake animated href=https://support.omniupdate.com/>Link to page</a>
```

Target Name

Note: The frame/frameset element is not included in HTML5. The Target Name field can be used to specify a target or browsing context for a hyperlink. By default when no target is specified, _self is assumed, but does not have to be explicitly set. Using target can also imply a new browsing context. The href attribute is required when utilizing target. The target can also be set on the General tab and if it is explicitly set there, the value is returned on the Advanced tab. The following predefined values can be used:

- _self -- Opens the link in the current window/frame/tab: Generally used for linking to pages within the institution’s website.
• **_blank** -- Opens the link in a new window. Generally used for linking to pages on another site, binary files like PDFs, in order to open content in a new browser tab.

• **_parent** -- Opens in a parent window/frame; previously common with framesets (pre-HTML5)

• **_top** -- Opens in a top-most parent frame to replaces all frames (pre-HTML5)

**Syntax**

```html
[target="_blank"]
```

**Language Direction**

Specifies the text direction (dir attribute) for the link. The HTML specification suggests that the use of dir is preferred over specifying text direction with CSS. It also allows for the value of the attribute to be "auto" but does not prefer it, even though the auto value allows for the direction to be determined programatically.

[4] The HTML specification provides an example of tagging that uses the value of auto for the dir on a paragraph. The first word of the paragraph is tagged with `<bdi>`, meaning that this particular word can go in either direction. Several examples are provided that include English, a left-to-right language, and Arabic, a right-to-left language. When rendered, the English language text is left aligned to the starting edge of the paragraph and the Arabic to the right. This includes the changing of the order of the `<bdi>` tagged words.

**Syntax**

```html
<a dir="ltr" href="https://support.omniupdate.com/">Link to page</a>
```

The dir attribute is global in HTML5. The drop-down provides the following choices:

• **Left to Right**: dir="ltr" -- The ltr state provides "directionally isolated" left-to-right text.

• **Right to Left**: dir="rtl" -- The rtl state provides "directionally isolated" right-to-left text.
Target Language

Specifies the language of the target content of the hyperlink. The hreflang attribute is considered a global attribute in HTML5. The hreflang attribute is used on a link to indicate the language of the content that is linked to as compared with the language of the hyperlink itself (the Language Code can be used for that).

Syntax

```
hreflang="sv"
```

According to the following W3C page, there are pros and cons to using hreflang, and perhaps caveats, but nonetheless may be useful in certain circumstances.

For more information and examples, visit the Indicating the language of a link destination.

From the site above is an example of hreflang usage, which is used in part here. The following example has a link that points to a page in Swedish and uses the hreflang attribute with language code for Sweden, SV. The styling is created in CSS. The result is that for each element with an hreflang attribute, the CSS adds the value of that attribute in brackets after the link.

Link example

"There is also a page describing why a DOCTYPE is useful [sv]."

HTML Markup Example

```
<p>There is also a page describing <a href="http://www.w3.org/International/articles/serving-xhtml/Overview.sv.php" hreflang="sv">why a DOCTYPE is useful</a>.
```

CSS Example
For more information about localizing languages for a global audience using HTML, visit the Authoring HTML: Language declarations (W3C working Group Note) page.

**Language Code**

Specifies the primary language (lang attribute) for content of the element, in this case a hyperlink and for any element attributes that contain text. The lang attribute is considered a global attribute in HTML5. "Its value must be a valid BCP 47 tag, or empty string. Setting the attribute to the empty string indicates that the primary language is unknown... If these attributes are omitted from an element, then the language of this element is the same as the language of its parent element, if any."

See this specification for specifics when using with XML or for using xml:lang: `attr-lang`.

**Example**

```html
```

The following language code lookup tool may come in handy:

http://rishida.net/utils/subtags/

**Target Character Encoding**

Obsolete for HTML5. Prior to HTML5, charset can be used to specify the encoding (charset attributes) for the target to which the hyperlink is linked. For example:

```html
<a charset="ISO-8859-1" href="https://support.omniupdate.com/">Link to page using ISO encoding.</a>
```

However, the default character encoding for HTML5 is UTF-8 as the unicode standard provides broader support for global localization with an inclusive set of characters, punctuations, and symbols. The standard also provides "processing, storage, and transport of text, independent of platform and language."

**Target MIME Type**

Specifies the MIME type for the hyperlink. The href attribute is required when utilizing type. This can be used to advise of the Internet media type of the linked resource. The value must be a valid MIME type, which might include an image, audio, or video media type. Examples of this string are:

- text/html
- video/ogg
- image/png

For more information about valid MIME types, visit the IANA MIME Types Registry page.

**Syntax**
Relationship Page to Target

Specifies a specific relationship (rel attribute) for the hyperlink to the target. One or more values can be provided for the attribute and if more than one is used they must be space separated. The meaning of some link type attribute values are determined in context by element or by combination usage with another attribute.

- The rel attribute is an extensibility mechanism that can be used "to annotate links"
- The HREF attribute is required when utilizing target.
- Link types are always ASCII case-insensitive, and must be compared as such; For example rel="next" is the same as rel="NEXT".
- It is not used by browsers so much as by search engines

"Similarly, for a and area elements with an href attribute and a rel attribute, links must be created for the keywords of the rel attribute as defined for those keywords in the link types section. Unlike link elements, however, a and area element with an href attribute that either do not have a rel attribute, or whose rel attribute has no keywords that are defined as specifying hyperlinks, must also create a hyperlink. This implied hyperlink has no special meaning (it has no link type) beyond linking the element's document to the resource given by the element's href attribute.

A hyperlink can have one or more hyperlink annotations that modify the processing semantics of that hyperlink."

Syntax

```html
<a rel="author" href="https://support.omniupdate.com/">Link to page</a>
```

Example

```html
<link rel=alternate type=application/pdf hreflang=fr href=manual-fr>
```

Note if the attribute usage is intended to create a hyperlink, it is indicated in the table below.

<table>
<thead>
<tr>
<th>Attribute Value</th>
<th>Link Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alternate</td>
<td>Hyperlink</td>
<td>Indicates that link target is an alternate representation of the current content. If used with the type attribute set to the value application/rss+xml or the value application/atom+xml, the keyword creates a hyperlink referencing a syndication feed (though not necessarily syndicating exactly the same content as the current page)</td>
</tr>
<tr>
<td>Attribute Value</td>
<td>Link Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>hreflang</td>
<td>Hyperlink</td>
<td>--If used with the <code>hreflang</code> attribute, and that attribute's value differs from the root element's <code>language</code>, it indicates that the referenced document is a translation. --If used with the <code>type</code> attribute, it indicates that the referenced document is a reformulation of the current document in the specified format. Example when use with hreflang and type: The following link is a French translation that uses the PDF format: <code>&lt;link rel=alternate type=application/pdf hreflang=fr href=manual-fr&gt;</code></td>
</tr>
<tr>
<td>author</td>
<td>Hyperlink</td>
<td>Indicates that link target is the author of the current content. --Intended to be a way to provide more information about the author --Can be used with mailto in order to provide the author's email address</td>
</tr>
<tr>
<td>bookmark</td>
<td>Hyperlink</td>
<td>Gives a permalink for the nearest ancestor <code>article</code> element of the linking element in question, or of the section the linking element is most closely associated with, if there are no ancestor <code>article</code> elements.</td>
</tr>
<tr>
<td>help</td>
<td>Hyperlink</td>
<td>Indicates that the target content provides help information. --On some browsers, the <code>help</code> keyword causes the link to use a different cursor</td>
</tr>
<tr>
<td>Attribute Value</td>
<td>Link Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Example</td>
<td>The following link hyperlink with the form element includes a mechanism whereby if the user presses the &quot;Help&quot; or &quot;F1&quot; key the target content is provided.</td>
</tr>
<tr>
<td>license</td>
<td>Hyperlink</td>
<td>Indicates that the main content of the current document is covered by the copyright license described by the referenced document. Another usage is if a piece of content is covered by a different license than the rest of the page. Consider the following example:</td>
</tr>
<tr>
<td>Attribute Value</td>
<td>Link Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>next</td>
<td>Hyperlink</td>
<td>Indicates that the current document is a part of a series, and that the next document in the series is the referenced document.</td>
</tr>
<tr>
<td>nofollow</td>
<td>Annotation</td>
<td>Indicates that the link is not endorsed by the original author or publisher of the page, or that the link to the referenced document was included primarily because of a commercial interest.</td>
</tr>
</tbody>
</table>

```html
<main>
  <figure>
    <img src="/pix/39627052_fd8dcd98b5.jpg">
    <figcaption>Kissat</figcaption>
  </figure>
  <p>One of them has six toes!</p>
  <p><small>This photograph is MIT Licensed</small></p>
</main>

<footer>
  <a href="/">Home</a> | <a href="../">Photo index</a>
  <p><small>© copyright 2009 Exampl Pictures. All Rights Reserved.</small></p>
</footer>
```
<table>
<thead>
<tr>
<th>Attribute Value</th>
<th>Link Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>relationship between people affiliated with the two pages.</td>
</tr>
<tr>
<td>noreferrer</td>
<td>Annotation</td>
<td>Requires that the user agent not send an HTTP Referer (sic) header if the user follows the hyperlink. It indicates that no referrer information is to be leaked when following the link.</td>
</tr>
<tr>
<td></td>
<td>External Resource</td>
<td>Specifies that the target resource should be preemptively cached.</td>
</tr>
<tr>
<td>prev</td>
<td>Hyperlink</td>
<td>Indicates that the current document is a part of a series, and that the previous document in the series is the referenced document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>--A document may be part of multiple sequences</td>
</tr>
<tr>
<td></td>
<td></td>
<td>--Content without a &quot;previous&quot; indicates that the sequence is at its beginning</td>
</tr>
<tr>
<td>search</td>
<td>Hyperlink</td>
<td>Gives a link to a resource that can be used to search through the current document and its related pages.</td>
</tr>
<tr>
<td>tag</td>
<td>Hyperlink</td>
<td>Indicates that the target link provides tag-like clarification or categorization for the current content.</td>
</tr>
<tr>
<td>non-predefined</td>
<td></td>
<td>The attribute values listed in this table above are predefined in the HTML5 specification. The spec also references additional values both existing and proposed for HTML5, which are listed at the microformats.org site: <a href="http://microformats.org/wiki/existing-rel-values">http://microformats.org/wiki/existing-rel-values</a> <a href="http://microformats.org/wiki/existing-rel-values#HTML5_link_type_extensions">http://microformats.org/wiki/existing-rel-values#HTML5_link_type_extensions</a></td>
</tr>
</tbody>
</table>
Some of the types described below list synonyms for these values. These are to be handled as specified by user agents, but must not be used in documents.

Authors can use the rel="" mechanism to annotate links with specific meanings by registering extensions to the predefined set of link types. This is also used by microformats. Additionally, absolute URLs that do not contain any non-ASCII characters, nor characters in the range U+0041 (LATIN CAPITAL LETTER A) through U+005A (LATIN CAPITAL LETTER Z) (inclusive), may be used as link types.


**Relationship Target to Page**

Note: The rev attribute is obsolete and no longer supported in HTML5. For pre-HTML5, it specifies the reverse relationship (rev attribute) for the hyperlink. If more than one value is used, they must be space separated. The rev attribute refers to the relationship between the target document and the current document; the opposite of the rel attribute.

**Syntax**

```html
<a rev="stylesheet">Link to page</a>
```

The rev attribute can take the following values:

- **alternate**: Indicates that the current document is an alternate version of the target document.
- **stylesheet**: Indicates that the current document is a stylesheet for the target document.
- **start**: Indicates that the current document is the first document
- **next**: Indicates that the current document is the next document compared with the link target
- **prev**: Indicates that the current document comes before the target content in a series.
- **contents**: Indicates that the current document is the table of contents for the link target
- **index**: Indicates that the current document is the index for the link target
- **glossary**: Indicates that the current document is the glossary for the link target
- **copyright**: Indicates that the current document contains copyright information for the link target
- **chapter**: Indicates that the current document is a chapter of the link target
- **section**: Indicates that the current document is a section of the link target
- **subsection**: Indicates that the current document is a subsection for the link target
- **appendix**: Indicates that the current document is the appendix for the link target
- **help**: Indicates that the current document is the help for the link target
- **bookmark**: Indicates that the current document is a bookmark for the link target

**Tab Index**

Specifies the tab index (tabindex attribute) for the hyperlink. The tabindex attribute is considered a global attribute in HTML5. The value must be a valid integer and is used to indicate that an element is focusable. "Positive numbers specify the relative position of the element's focusable areas in the sequential focus navigation order, and negative numbers indicate that the control is to be unreachable by sequential focus navigation."

- A tabindex makes an element selectable by mouse click in that it adds dotted outlines, which can be styled using :focus
- May be more useful in changing the tab-through order of a form than for changing the tabbing order of links on a page
- Since `<a>` tags have focus by default, could also be used to negate the tabbing through a page
Syntax

```html
<a tabindex="1" href="https://support.omniupdate.com">Link to page</a>
```

**Access Key**

Specifies one or more access keys (accesskey attribute) assigned to the hyperlink. The accesskey attribute is considered a global attribute in HTML5. "If specified, the value must be an ordered set of unique space-separated tokens that are case-sensitive, each of which must be exactly one Unicode code point in length." The accesskey attribute:

- Creates a keyboard shortcut that activates or focusses the element
- Can include more than one key

**Syntax**

```html
<a accesskey="access-key" href="https://support.omniupdate.com">Link to page</a>
```

**onclick**

Executes Javascript when the link is clicked.

**Example**

```html
<a href="https://support.omniupdate.com" onclick="getElementById('demo').innerHTML=Date()">What is the time?</a>
```

**More Options for Inserting and Using Links**

For more information about the additional functionality available on the other tabs, see:

- Anchors
- Mailto Links
- Additional Tabs (Classic Editor Only)
Insert/Edit Image

Overview
The Insert/Edit Image tool is available on the default toolbar for the WYSIWYG Editor. The Images Gadget may also be used to drop an image on a page and will automatically spawn the Insert/Edit Image modal.

Classic Editor

JustEdit

The Insert/Edit Image tool provides access to multiple functions related to images, image management, and code markup for images. At the very simplest, it can be used to link to an image and provide a description for it, which is usually required. On the other hand, Insert/Edit Image can also be used to:

- Upload an image and edit it with the Image Editor
- Manually enter a URL of an image to insert on the page
- Browse to an image that was previously uploaded in order to link to it, including the ability to choose from an auxiliary site
- Provide metadata about an image in the form of an Image Description (alt tag) and Title (title tag)
- Preview an image
- Align an image
- Add space or a border around an image
- Assign a CSS class or styling to an image
- Create an image swap with JavaScript
- Specify an image map

When using the Insert/Edit Image tool, once an image has been selected for insertion on a page, the WYSIWYG Editor provides the HTML mark-up and the dependency tag for the link behind the scenes. A dependency tag can also be inserted from within the Source Editor.

In addition to adding an image to a page, the Insert/Edit Image tool includes the Appearance and (for Classic Editor) Advanced tabs, which provide users with the ability to further manipulate images. The Appearance tab provides the ability to modify the alignment, size, and CSS styling of the image. The Advanced tab provides miscellaneous functionality for image manipulation with JavaScript and HTML, including the ability to swap images on mouse over, designate an image map, and add an ID to the IMG tag.

Inserting an Image

1. To insert an image, position the cursor where the image should be inserted and click the Insert/Edit Image icon. This shows the Insert/Edit Image modal.
2. The location of the image can be manually entered in the Image URL field, but to take full advantage of link management, click the **Browse** icon to browse to the image as in this manner the image will be assigned a dependency tag.

![Browse Icon]

3. The **Select Image** modal is shown.

![Select Image Modal]

Note that the view of the images can be toggled between a list and thumbnail view by clicking the icons to the right of the Filter field.

4. An image can be selected by doing one of the following:
   - Navigating the folder structure via the breadcrumb links. This includes being able to navigate to another site within the account.
   - **Uploading** an image.
• **Uploading and editing** an image.
• Selecting a different environment from the drop-down; such as the production server or publish target. Staging is the default when Binary Management is in effect.
• Selecting an auxiliary site from the drop-down.
• Filtering by entering one or more characters. The filter is relevant to the file name, including extension.
• Filtering by adding tags.
• Switching between list view and thumbnail view.
• Previewing in the preview pane by single-clicking.
• Double-clicking to immediately select and insert.
• Viewing the preview pane content details
• Clicking through the Edit Image link to edit an image. After editing, click save to return to the Select Image dialog. This edits the physical file and can be useful for quick resizing of an image.

5. Once the image has been selected, click **Insert**. Alternatively, double-click an image in the list or thumbnail view.

6. From the **Insert/Edit Image** modal, enter a value for the **Image Description** field.

7. Click **Insert**. The image is shown in the context of the page within the WYSIWYG Editor.

Note: When linking to an image or other binary file from staging the file must be published to production. This can be accomplished by making sure that the **Include Unpublished Dependencies** checkbox is selected.

**Editing an Inserted Image**

The details of the image can be modified after insertion on a page by clicking the same **Insert/Edit Image** icon, making the necessary edits, and clicking **Update**.

**Dragging a File to Upload**

1. As described above, click the **Insert/Edit Image** tool, and the **Browse** icon.
2. From the Insert Image modal, click **Upload**.
3. Drag the file or files to upload from the local computer to the modal. (Multiple files may be selected and uploaded at one time. On a PC, use Control+Click, Shift+Click, or click and drag to select multiple files. For a Mac, use the Command key to select multiple files.)
4. Alternatively, click the Add Files button to browse and select local files.
5. If necessary and available, choose an access group for the files. This will limit the ability to access the image to insert it on a page from within the WYSIWYG to members of the group.
6. The ability to overwrite files may be enabled and available by clicking the Overwrite Existing checkbox.
7. Files may be renamed at this point by clicking Rename, entering the new file name, and pressing the Enter key or clicking out of the field.
Note that if there are invalid filenames or the file exists already and Overwrite Existing has not been checked, the modal will not allow the upload to be initiated.

8. Click **Start Upload** to upload the files.

   When completed, the green success message is displayed

   . Click

   **Close**
   
   and select and insert the image from the

   **Select Image**
   
   modal.
Additional Information and Reminders

- Adding an image description is important for accessibility, as it provides text for screen-readers or other instances where the image is unable to be viewed.
- The ability to upload files is inherently available for user levels 6 or above. Lower level users (1–5) can be granted the rights to upload via the user’s settings.
- The permission to overwrite files to which they have access can be granted to user levels 1 through 8, and is inherently available to user levels 9 and 10.
- To import multiple files using only one selection and containing subfolders, use the Zip Import feature.
- Zip Import is available to users Levels 6–8 through the user’s settings.
- **Note:** All binary files including images are uploaded to the staging server and must be published to the public-facing web server. Image files can be manually published with any publish action, or if having been inserted on a page without publishing, the Dependency Manager will provide a checkbox on the Publish modal so that any unpublished dependencies are also published.

Decorative Images

Decorative images are images for which no `<alt>` descriptive image tag is required. Inserting decorative images must be enabled for each site by an administrator. This can be accomplished from Setup > Sites > WYSIWYG Editor > Decorative Images. The default, Disabled, means that the Decorative Image checkbox is not available and that an Image Description must be added.

For more information, visit the Setup Sites > WYSIWYG Editor Panel page.

Using Decorative Images

Once enabled, the Insert/Edit Image modal in the WYSIWYG editor allows users to select a checkbox indicating that the image to be inserted is a decorative image and to omit the image description.

Appearance Tab

The Appearance tab allows for configuring the alignment, size, and styling of the image.
The following Appearance settings can be configured:

- **Alignment**: Sets the alignment of the image against the text. Options include:
  - Baseline: Aligns the baseline of the image with the baseline of the parent
  - Middle: The image is placed in the middle of the line of text
  - Top: The top of the image is aligned with the top of the tallest element in the line
  - Bottom: The bottom of the image is aligned with the bottom of the lowest element in the line
  - Text Top: The top of the image is aligned with the top of the parent element
  - Text Bottom: The bottom of the image is aligned with the bottom of the parent element's font
  - Left: The image is set to the left of the text with wrap-around
  - Right: The image is set to the right of the text with wrap-around

- **Dimensions**: Sets the height and width of the image. The **Constrain Proportions** checkbox can be selected in order to keep the same proportions of the original image. Dimensions can be set to a pixel value or a percentage (for responsive images).
  - In JustEdit, the dimensions are listed under the General tab

- **Vertical Space**: Sets the amount of space between the top and bottom sides of the content area and the image

- **Horizontal Space**: Sets the amount of space between the left and right sides of the content area and the image

- **Border**: Sets the width of the image border. The border width will be the same on all sides of the image
• **Class**: Allows for a class attribute value to be selected from the drop-down, which can be configured.

• **Style**: Based upon the options selected from the Alignment drop-down, the styling will auto-complete. Optionally, styling may be manually added to define the alignment and other features for the image.

**Advanced Tab**

If you are using the Classic Editor, the **Insert/Edit Image** modal also contains an **Advanced** tab. It provides easy access to JavaScript and HTML with the ability to swap images on mouse over, designate an image map, and add an ID to the IMG tag.

**Swap Image**

The Swap Image area includes a checkbox that, when selected, allows for adding a second image that replaces the original image when a user hovers over the image. The two options for this feature are to specify the alternate image on mouse over or on mouse out. For either option, the alternative file can be browsed to with the file chooser.

1. While editing a page in the WYSIWYG Editor, click **Insert/Edit Image**.
2. Click the **Browse** icon and select the image to appear on the page when it is initially loaded.
3. Click the Advanced tab.
4. Select the **Alternative Image** checkbox.
5. From either the **For Mouse Over** or **For Mouse Out**, browse to the alternative image.
6. Insert the image, and save and publish the page.
Initial Image

![Middle Earth](image1.jpg)

Image Swap After Hover

![Middle Earth](image2.jpg)

Miscellaneous

This area includes the ability to add the HTML `id` tag to the `img` tag. It also includes:

- Add the HTML `id` tag to the `img` tag
- Select the language direction with a drop-down
- Designate the language code
- Specify an image map
- The long description link field

**ID**

Specifies the value of the `id` attribute for the image. In previous incarnations of HTML, the name attribute on an `<a>` element was used to create an anchor and target it. For conformance with HTML5, the `id` attribute is preferred over the name attribute. For OU Campus pages the `id` should at least be unique to a page. The `id` attribute is flexible in implementation and can provide a specific target for an element, including for on-page linking within a document. An `id` can also be used as a target by scripts. Another usage of `ids` is to style an element with CSS, or to bookmark or footnote a document.

An `id` attribute:

- Is a global attribute in HTML5
- Must be a unique value relative to the "element's home subtree"
- Must contain at least one character
- Must not contain any space characters

**Language Direction**

Specifies the text direction (dir attribute) for the image. The HTML specification suggests that the use of `dir` is preferred over specifying text direction with CSS. It also allows for the value of the attribute to
be "auto" but does not prefer it, even though the auto value allows for the direction to be determined programatically. The HTML specification provides an example of tagging that uses the value of auto for the dir on a paragraph. The first word of the paragraph is tagged with <bdi>, meaning that this particular word can go in either direction. An example would be differentiating between English, a left-to-right language, and Arabic, a right-to-left language. When rendered, the English language text is left aligned to the starting edge of the paragraph and the Arabic to the right. This includes the changing of the order of the <bdi> tagged words.

**Language Code**

Specifies the primary language (lang attribute) for content of the element, in this case a hyperlink and for any element attributes that contain text. The lang attribute is considered a global attribute in HTML5. "Its value must be a valid BCP 47 tag, or empty string. Setting the attribute to the empty string indicates that the primary language is unknown... If these attributes are omitted from an element, then the language of this element is the same as the language of its parent element, if any."

See this specification for specifics when using with XML or for using xml:lang: **attr-lang**.

**Image Map**

In HTML and XHTML, an image map is a list of coordinates relating to a specific image, created in order to hyperlink areas of the image to different destinations (as opposed to a normal image link, in which the entire area of the image links to a single destination). For example, a map of the world may have each country hyperlinked to further information about that country. The intention of an image map is to provide an easy way of linking various parts of an image without dividing the image into separate image files.

To use the image map feature in the advanced properties of the WYSIWYG image insert tool, the web developer must have first created a properly coded image map with the appropriately defined hotspots in the HTML of the target web page. The image map must be named (e.g., name="navmap"). Once this is done a user can, in the WYSIWYG Editor, click the Insert/Edit Image tool, choose the appropriate image, go to the Advanced tab, and type in the name of the image map. This name must be preceded by a # character (e.g., #navmap). Now the image is associated with the image map.

Due to the nature of image maps (dimensions are hard set for the hot-linked areas of an image), an image must be of the proper dimensions to support the map, as well as have the image content that maps to the areas that are defined in the image map (e.g., an image of Canada would be useless for an image map defined for the United States).

**How to Add a Mapped Image**

1. To add a image map to the page, use the WYSIWYG **Insert/Edit Image** tool.
2. From the **Insert/Edit Image** dialog box, click the **Advanced** Tab.
3. In the **Image Map** field type in the name of the image map. It is very important to keep in mind that a hash tag (#) must be placed at the beginning of the image map name in this field. For example if the developer used the name *navmap*, the user would type in: `#navmap`.

4. Once the correct name has been inserted for the image map click **Insert** and the new mapped image will appear in the **WYSIWYG Editor**.

**Long Description**

The long description field specifies a hyperlink to a detailed description of an image.
Image Editor

Overview

The Image Editor allows images to be resized, cropped, rotated, and zoomed directly within OU Campus. Images can be uploaded and edited all in one operation.

The ability to edit an image helps ensure large images are properly resized before being published to the production server. Additionally, images can be saved and renamed.

Access to the Image Editor is dependent on user level. Those who can upload files can use the Image Editor to upload images and edit existing images, but cannot overwrite any existing image with the same file name. Those with overwrite permissions are able to replace existing images. The Image Editor can be accessed using the following methods:

- Clicking on a linked image name within the Pages list view
- Clicking Upload and Edit from the Upload modal when uploading an image in the Pages list view
- When inserting images into an editable region from the Insert/Edit Image filechooser while in the WYSIWYG Editor
- When inserting images into a mini-WYSIWYG editor from the Insert/Edit Image filechooser while editing or creating a new Web Content Asset
- When inserting images on a page using the Source Editor

For more information about the Upload and Edit process, visit the Upload and Edit page.

LDP Image Galleries are another way users can add images to a site in the OU Campus system. However, this function is not related to the standard Upload and Edit Image feature and requires that Live Delivery Platform (LDP) be enabled. For information about creating LDP Image Galleries, visit the Image Galleries page.

Image file types support by the Image Editor is browser dependent. The following file types commonly used for web pages can be edited and saved with the Image Editor with the most commonly used browsers:

- JPG/JPEG
- PNG
- GIF
• BMP

For a complete reference of browser support for image formats, see:

## Accessing the Image Editor

The Image Editor can be accessed in three main ways:

• Click the hyperlinked image name in the Pages list view

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Modified</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>classroom.jpg</td>
<td>21.5K</td>
<td>4/29/15 11:36 AM</td>
<td></td>
</tr>
<tr>
<td>faculty.jpg</td>
<td>13.5K</td>
<td>4/29/15 11:36 AM</td>
<td>Edit</td>
</tr>
<tr>
<td>grad-students</td>
<td>15.2K</td>
<td>4/29/15 11:36 AM</td>
<td></td>
</tr>
</tbody>
</table>

• When uploading an image, click **Upload and Edit** from the Upload modal

![Upload modal](image)

• When adding an image to an editable region, the source of a page, or in a mini-WYSIWYG Editor and uploading from the **Select Image** filechooser
Image Editor Tools

From the Edit Image screen inside the Image Editor, the following functionality is available in the Tools menu:

- Resize
- Crop
- Rotate
- Zoom
- Undo
- Redo

As the image is edited, an estimated file size is shown underneath the image panel. This size will change as the image is resized and cropped.

Resize

The Resize tool includes the ability to specify a new width and height for the image. The original ratio for the image dimensions can be kept intact by selecting the Preserve Ratio checkbox.
Crop

The Crop tool can be used to crop the image, either by selecting a predefined aspect ratio or by determining a custom crop size. When Custom or any of the predefined ratios are selected, a crop box will appear. Users can then adjust the crop for the image by dragging the crop handles located on the edges of the crop box. Clicking the Swap width & height checkbox will swap the dimensions of the crop box width and height (e.g., a crop box with dimensions of 150x300 pixels would swap to 300x150 pixels).
Rotate

The Rotate tool rotates the image 90 degrees in a clockwise direction with each click.
**Zoom**

The Zoom tool can be used to manually enter a percentage of the original image size to be displayed in the Edit Image panel for editing. The plus and minus magnifying glass buttons may also be used to increase or decrease the viewing size. Zoom does not alter the size of the image on the staging server; it is only to aid users in the Image Editor.

The Original button reverts the image to the original size.

The Zoom to Fit button resizes the image to fit into the panel for viewing.
Undo/Redo

The Undo and Redo functionality is available after performing another editing function. **Undo** reverts the last function performed (one level back). The **Redo** function reapplies the last function removed by the **Undo** tool (one level forward).

Final Notes

The edited image must be republished in order to appear correctly on the rendered webpage. This may be initiated with a page publish by selecting the checkbox to publish unpublished dependencies. Or it may be necessary to manually publish the image. If the image does not appear correctly, refresh the browser and/or clear the browser cache as the previous iteration of the image may have been saved by the browser. This action can be found in various places in browsers’ settings and for some browsers/platforms, this can be accomplished by pressing CTRL+F5 (Chrome), CTRL+R (Firefox and IE), or CMD+Option+E (Safari). Otherwise the edited image may not appear as expected.

When an image is edited through The Image Editor in OU Campus, it will be recompressed once it is saved. When using lossy file formats such as JPG, this can cause a visible degradation in image quality, especially when an image is edited multiple times in OU Campus. As a best practice, crop or resize images to the exact size needed on the page before importing them into OU Campus. Furthermore, using images saved in a lossless file format (such as PNG) in the Image Editor will avoid losses of quality due to recompression.

The image size is dependent on two factors: the browser and the amount of memory allocated to the browser by the parent machine. In testing a fairly large image, 13260 x 3955 pixel (27 MB), was used and rendered in 198 ms. Performance of image rendering is dependent upon each individual user’s machine and Internet connection. In short, every time a user tries to load an image, large or small, jpeg or any other extension, the image editor relies on the browser to provide the pixel information.

If working with an image that cannot be edited, log out of OU Campus, quit and relaunch the browser. This will free up browser-allocated RAM and may resolve the issue.
Insert/Edit Embedded Media

Overview

The Insert/Edit Embedded Media or Insert/Edit Video tool on the WYSIWYG Editor toolbar allows users to include markup for video, movies, and audio on a page. This embeds the proper markup such as the video tag or object in order to add the proper media player for the media type. Attributes/parameters for specific media types can configured on the Advanced tab.

Classic Editor

JustEdit

Users can link to media from external sources, as well as upload files directly to OU Campus.

Note: If HTML5 schema is not in use for the WYSIWYG Editor, HTML5 tagging may not be supported on the rendered page. An administrator may cautiously enable the schema for the WYSIWYG Editor.

For more information about HTML5 and schemas, visit the WYSIWYG Editor in Site Settings page.

This section includes the following topics:

- Inserting Media: Instructions on inserting media into a page while editing.
- General Tab: Allows users to specify the media type and the URL for the media file.
- Source Tab: Provides a source code view of the markup for the video.
- Final Notes/Troubleshooting

The Advanced Tab is also available when utilizing the Classic Editor; for more information, visit the Advanced Tab page.

Inserting Media From OU Campus

1. Edit a page with the WYSIWYG Editor.
2. From the toolbar, click the

   Insert/Edit Embedded Media icon.

   This shows the Insert/Edit Embedded Media modal.
Insert/Edit Embedded Media

**General**

- **Type**: Flash
- **File/URL**: [File Explorer]
- **Dimensions**: 320 x 240
- **Constrain Proportions**: ✔

**Preview**

Insert  | Cancel
3. If you are in the Classic Editor, select a **Type**. By default Flash is select, but HTML5 and several other types are available. If you are using JustEdit, it will automatically detect the type.

4. From the **File/URL** or **Source** field select the **Browse** icon and use the file chooser to select the media file.

   A media file can be selected from any environment to which the user has access; specifically, staging, production, auxiliary sites, the folder structure within the site, and among sites within an account. Media files may be filtered by name or searched for by tag.

   At this point, one or more files may also be uploaded, and one can be selected to embed on the page.

   For more information on uploading files, visit the **Upload page**. Keep in mind that your institution may have a designated folder for uploading resources.
5. Once the media file is selected, click **Insert**.
6. Configure any other options on the modal tabs, and click **Insert** or **OK** again.

The media does not render within the WYSIWYG Editor. Instead a placeholder box the size of the intended media is displayed. Once the page is saved, the video renders in the preview. Depending upon the configuration, the file may need to published before it will play in preview.
Inserting Media from an External Source

In addition to uploading media files to OU Campus and inserting them with the WYSIWYG Editor, users can also link to media files from external sources, such as YouTube or other similar video-sharing services. This method uses an <iframe> tag.

1. Locate the video on an external video sharing service such as YouTube.
2. Copy the URL for the video from the top address bar.
3. Return to the page in OU Campus where the video should be placed, and place the cursor at the location where the video should be displayed.

4. Click on the **Insert/Edit Embedded Media** icon in the WYSIWYG toolbar.

5. If you are in Classic Editor, in the **General tab > Type** field select **Iframe**. Paste the file’s URL into the **File/URL** box.

6. If you are in JustEdit, paste the URL into the **Source** field.

7. When complete, click **Insert**.
General Tab

The General tab in the Insert/Edit Embedded Media tool is used to determine the type of media file that will be inserted, which will determine the markup that will be used. Also, the media file URL can be specified here or a file selected with the use of file chooser/browse icon.

- **Type (Classic Only)**: Select the media type; this determines the markup and/or player that will be used for the media:
  - HTML5 Video
  - HTML5 Audio
  - Flash (default)
  - Transcode-It
  - QuickTime
  - Shockwave
  - Windows Media
  - Real Media
  - Iframe

- **File/URL or Source**: The file can be browsed to within the folder structure of the site, uploaded, or a URL from an external source such as YouTube can be used.

- **Alternate Source (JustEdit Only)**: If you have a secondary source for the video, such as another location where it was uploaded, you can paste it here. The alternate source will display in case the source is unavailable.

- **Dimensions**: Height and width of the media in pixels, which will determine how it renders on the page. Constrain Proportions can be selected to maintain the original ratio of the media.

- **Preview (Classic Only)**: Some media types, depending upon browser configuration and if the media file has been published, will render a preview.

- **Poster (JustEdit Only)**: If you insert a video from a local source, you can upload a thumbnail image for it by using the file chooser.

Source/Embed Code

The **Source** or **Embed Code** tab of the Insert/Edit Embedded Media modal provides users a space where they can directly post the embed code of their video.
<object width="320" height="240"
data="http://www.youtube.com/channel/UCT1qgoZhka3RWHHYJFSg1LQ"
type="application/x-shockwave-flash"><param name="src" value="http://www.youtube.com/channel/UCT1qgoZhka3RWHHYJFSg1LQ"/><param name="sound" value="true"/><param name="progress" value="true"/><param name="autostart" value="true"/><param name="swstretchstyle" value="none"/><param name="swstretchhalign" value="none"/><param name="swstretchvalign" value="none"/></object>
Final Notes/Troubleshooting

The WYSIWYG Editor uses the XHTML schema to validate the content when saving. In the case of an `<iframe>`, the "name" attribute is deprecated for XHTML, and is removed. Instead, try using the ID attribute, or id="iframename".

There are a few reasons why a video may not render:

- The browser used to view the page does not have the correct plugin.
- The type of media specified is incorrect for the media. Make sure the video appears in the Preview screen inside of the Insert/Edit Embedded Media window.
- The video file has an incorrect or invalid file extension.

If you are embedding a Youtube video on a page by taking the embed code Youtube provides and pasting it into the source code of a page, you may encounter an error where the page cannot be edited. This is caused by a small error in the embed code that is easily fixed.

The recommended course of action for embedding videos is to do it through the Insert/Edit Video tool in the WYSIWYG editor by pasting in the URL of the video. However, if you are using the embed code provided by Youtube, it can be fixed in the following manner.

Within OU Campus, iframe elements (such as the Youtube embed code) cannot be empty between the `<iframe>` and `</iframe>` elements. A code such as this will break the page:

```
<iframe width="560" height="315" src="insert-youtube-link-here" frameborder="0" allowfullscreen></iframe>
```
However, this can be solved by adding a nonbreaking space in between the elements, like so (bolded for emphasis):

```
<iframe width="560" height="315" src="insert-youtube-link-here" frameborder="0"
allowfullscreen>&nbsp;</iframe>
```

Or alternatively, another solution might be to add in a comment:

```
<iframe width="560" height="315" src="insert-youtube-link-here" frameborder="0"
allowfullscreen> <!--add a comment to prevent iframe from being empty--> </iframe>
```

In either case, having the value in between the starting and closing `<iframe>` elements will prevent an empty iframe, which should resolve any of those errors.
Rename

Overview

The Rename features allows users to rename files. The file is renamed on the staging and the production server. User levels 8, 9, and 10 have the ability to rename files, and Level 8 users can only rename files to which they are assigned access rights. It is important to note that files renamed on the staging server change the associated files on the production server, but files renamed on the production server do not change the file name on the staging server.

Using the Rename feature only renames a file; it does not convert between file types. Generally, file extensions should not be renamed as this can corrupt a file and render it unreadable by the system. This can be particularly fatal for binary files; for example, renaming image.png to image.jpg does not convert the PNG to a JPG. This is also true of other file types. Some text file types might survive the changing of an extension (for example, changing HTM to HTML), but generally the Rename feature is intended to be used to only change the file name and not its extension.

Directories can be renamed as well. Visit the Directory Options page for more information.

Renaming a File

A file can be renamed from the Pages list view by hovering over the row and selecting Rename from the File menu. Note that a file does not have to be checked out to be renamed.

- To rename a file, navigate to the Pages list view, hover over the desired file, and from the File menu, click Rename.
- Input the new file name.
- When the new name has been added, click away from the box or press the Enter key. Alternatively, press the Escape button to cancel the rename.

While some extensions can be changed, PCF file types cannot. Likewise, a file extension cannot be changed to PCF.

Note: if Dependency Manager is enabled and a file that is referenced on another page is renamed, the Confirm Rename modal will appear indicating how many pages will need to be republished should the rename process be completed. To continue, click OK. This will republish the affected pages based on the current version of the page on the live production server with the new dependency links. If changes have been made but not published to the live site, those changes will still not be published to the live production server but will be available in OU Campus and still saved on the staging server. This includes any versions.
For more information about dependency manager, refer to the Dependency Manager page.
Copy

Overview

The Copy function can be used to copy one or more pages or files. Copying a file automatically renames the copy by appending a number. Level 9 and 10 users can copy all files. Levels 8 users have the ability to copy files, but only files to which they have assigned access rights. It is also important to note that copying files and folders can only occur on the staging server. Copies of assets cannot be made.

Copying Files

A file can be copied from the Pages list view by hovering over the File menu and selecting Copy, by selecting the checkbox adjacent to a file, or by using the drag-and-drop feature. The location to copy to can be browsed to or entered manually. Additionally, an option can be selected to show the files in a directory. Note that a file does not have to be checked out to be copied (unless copying from the File Navigation sidebar), and can be copied when it is checked out to another user or when it has a scheduled action associated with it.

Multiple files can also be copied at the same time by selecting multiple checkboxes adjacent to each file. All files within a directory may be selected at one time by clicking the checkbox at the top of the list.

Copying Files from the Pages List View

To copy a file do one of the following:

1. From the Pages view, hover and from the File menu select Copy. Or, from the Pages view, select the checkbox for one or more files (and/or directories) and from the top row click Copy.

2. Then, from the modal that appears, browse to the directory path to which to move it. Click the Show Files checkbox to view the files and subdirectories.
Copying Files by Drag and Drop

A file may be copied by checking out the file and then dragging the file from the File Navigation sidebar to the desired location in the main content area.

1. Navigate to the appropriate directory for the file to be copied to in the Pages view.
2. Expand the File Navigation sidebar using the folder button in the top left of the screen, and locate the file to be copied.
3. Check out the file.
4. Holding **Control** (PC) or **Option** (Mac), drag the file from the File Navigation sidebar into the directory to where the file should be copied.

5. A confirmation modal will appear. Click **Copy**.
Move /admissions/studentresources.pcf

Please confirm you wish to move the following items to /about
/admissions/studentresources.pcf

Cancel  Move
Move

Overview

The Move function allows users to move one or more files at a time. Only user levels 8, 9, and 10 can move files, and a Level 8 user can only move files to which they are assigned access rights. It is also important to note that moving files and folders will move them on both the staging and production servers. If a page or file has not been published, it will only be moved on staging. If Multi-Target Publish is in affect, the files are moved on any target to which it has been published.

Moving a Single File

A file can be moved from the Pages list view by hovering over the desired file and from the File menu, selecting Move; by selecting the checkbox adjacent to a file and clicking Move in the table header; or by dragging and dropping the file. Note that a file does not have to be checked out to be moved.

Moving a File from the Pages List View

1. To move a file, do one of the following:
   • From the Pages list view, hover over the desired file row and from the File menu select Move.
   • From the Pages list view, select the checkbox or checkboxes to the left of the file name(s) and from the table header click Move.

2. In the Move modal, browse to the directory to which the file should be moved. Click the Show Files checkbox to view the files that reside within each directory.
3. When the desired directory is located, click the Move button.

Moving a File using Drag and Drop

A file may be moved by dragging the file from the File Navigation sidebar to the desired location in the main content area.

1. Navigate to the appropriate directory for the file to be moved to in the Pages list view.
2. If necessary, expand the File Navigation sidebar using the folder button in the top left of the screen, and locate the file to be moved.
3. Drag the file from the **File Navigation** sidebar into the main content area to where the file should be moved. Directory rows that appear in green are valid locations to move the file.

4. A modal will appear to confirm the desire to move or copy the file to the new location. Click **Move**.
Moving Multiple Files

Multiple files can be moved at once by selecting the checkboxes found to the left of each file, and then clicking the Move button in the table header. All files and subdirectories within a directory may be selected at one time by clicking the checkbox at the top of the list. Note that files do not have to be checked out to be moved.

1. To move multiple files at one time, do one of the following:
   • From the Pages list view, select the checkbox in the table header to select all files, and click Move.
   • From the Pages list view, select the checkbox for each file to be moved and from the table header, click Move.

2. In the Move modal, browse to the directory to which the file should be moved. Click the Show Files checkbox to view the files that reside within each directory.
3. When the desired location has been selected, click the **Move** button.

**Note:** If Dependency Manager is turned on, a prompt will appear when moving a file or files indicating how many pages will need to be republished should the move process be completed. To continue, click **OK**.
Dependency Manager republishes any pages that link to the newly-moved page based on the current version of the pages on the live production server. If changes to the linking pages have been made and saved to the staging server, but not been published to the live site, those changes will still not be published to the live production server until they are manually published by a user. This includes backed up versions that have been manually created.

For more information about Dependency Manager, visit the Dependency Manager page.
Recycle

Overview

The Move to Recycle Bin function allows a user to remove a file from the staging and production servers and place it into the Recycle Bin, where from which it can be either restored or permanently deleted at a later time. Files can be recycled by hovering over the file row in the Pages list view, and selecting Move to Recycle Bin from the File menu. User levels 8-10 have the inherent ability to send files to the Recycle Bin, though administrators can grant this ability to user levels 1-7 on a per-user basis if desired.

For more information concerning the Recycle Bin itself, including restoring content, visit the Recycle Bin page.

When a file is moved to the Recycle Bin, derivatives on the production server or any publish targets are subsequently permanently deleted. If content is restored from the Recycle Bin, it must be republished to make the content available on the website again. Files that are locked to another user or pending a user’s approval cannot be recycled. An administrator needs to check in a page that is locked by another user before it can be recycled.

If the Recycle Bin is not configured for a site, then files can only be permanently deleted rather than recycled. Additionally, files that reside on a production target as well as directories cannot be recycled; they can only be deleted. More information on deleting files or directories can be found on the Delete page.

Moving a File to the Recycle Bin

1. From the Content > Pages view, hover over the file row and from the File menu choose Move to Recycle Bin.
2. Alternatively, one or more files can be selected by clicking the checkbox next to each file name and clicking

   Move to Recycle Bin in the table header.
3. The resulting modal will notify the user of any pages that link to the soon-to-be-recycled file. Users can click the links to open each page in a new tab, in order to quickly fix the resulting broken links from the recycle.

![Modal Notification](image)

4. Click **Move to Recycle Bin**.
Delete

Overview
Pages, files, and directories can be deleted from the Production server, and directories can be permanently deleted from the Staging server with their contents. Only level 9 and 10 users have the ability to delete from Production.

An item may be deleted from the Production server without affecting the item in Staging, though the only way to restore that item to Production will be to republish it from Staging.

Files are removed from the Staging server by recycling them. For more information, visit the Recycle page.

Deleting a File
Files can be permanently deleted from the Pages list view on Production.

1. Navigate to the Pages list view and locate the file to be deleted.
2. Hover over File on the page row and select Delete.
3. On the production server, hover over the file row in question and select Delete under the Options menu.
4. A modal will appear to confirm the delete. Click the red Delete button.

Deleting Multiple Files
1. Navigate the folder structure in Content > Pages and locate the files that are to be deleted.
2. Select the appropriate checkboxes for each file. The checkbox in the table header selects all files in the directory.
3. Click the Delete button in the table header.

Note: Deleting a file or files removes any previous versions or backup version.
Deleting a Directory

Directories that are deleted are done so permanently. Directories cannot be recycled on the staging or production server. If the Recycle Bin is available for the site, all files in the directory can be recycled first, and then the directory may be deleted. This allows the directory to be recreated and the files restored if necessary; otherwise, deleting a directory will delete all contents on both staging and production servers. Files within a directory that are deleted are removed from any previous versions, as well as backups.

Navigate the folder structure in Content > Pages and locate the desired directory.

1. A directory can be deleted by hovering over the File menu and selecting Delete.
2. Alternatively, a directory can be deleted by selecting the checkbox next to the directory, and selecting Delete from the table header.
3. A modal will appear to confirm the delete. Type “delete” and click the red Delete button.

Note: Just as with Recycling, deleting any items from the staging server will remove them from production as well.
Review

Overview

The Review menu allows users to view information about a page, file, or Asset. Users can review pages and binary files from either the Pages list view or from the Page Actions toolbar. Assets can be reviewed from the Assets list view or the Asset Actions toolbar.

The options available in the Review menu are dependent on user permission level as well as the current status of the content. Content that is not checked out will have fewer options available. Pages that are not checked out will only have the following options available by default:

- Preview
- Log

Content that is checked out will display the following options by default:

- Preview
- Page Check
- Save Version
- Versions
- Log

Not all users will have the same permissions and therefore may not have the same options available even if the content is checked out.

Preview

Prior to checking out or editing a page, a page can be previewed. This view gives users the ability to see what the page will look like once published. Users will not be able to edit the page via the WYSIWYG or Source Editor from this view; they must go to the Edit or Source view, respectively, to edit. Preview does
allow for server selection, which can be used in conjunction with Multi-Target Publish to provide views of
different variations of the same page prior to publishing to the live production server.

For more information, visit the Preview page.

**Page Check**
The system includes methods for configuring several "checks" that can be run manually and/or at the time
of page publish, and which can be required to be performed. The available checks include tools for spell
check, link check, page validation, and an accessibility check of which one of several specifications can be
designated.

For more information, visit the Page Check page.

**Save Version**
Clicking Save Version will manually commit the version of the page or file that currently exists on the staging
server to the versioning system, which is accessible via Review > Versions.

For more information, visit the Save Version page.

**Versions**
The Versions tool allows users to access and review previous saved versions of content.
If or when necessary, users can revert to any previous version of a page. The current state of the page on
staging can be compared with the page's
current published version or any previous version. The resulting comparison includes a color-coded markup
indicating how the pages differ.

For more information, visit the Versions page.

**Log**
In addition to the built-in versioning system, the system also maintains a log file for a page. This displays
all of the saves and publishes, whether manual, scheduled, or if it was part of a directory publish, that have
occurred for a specific page.

For more information, visit the Log page.
Preview

Overview
Prior to checking out or editing a page, a page can be previewed, giving users the ability to see what the page will look like once published. This view provides limited functionality in that no buttons are available for editing or saving the file.

Preview does allow for server selection, which can be used in conjunction with Multi-Target Publish to provide views of different variations of the same page prior to publishing to the live production server.

The Preview screen also allows users to use Multi-Browser Preview and Multi-Output Preview. Multi-Browser Preview is a handy test tool to preview a page as it is rendered by any number of browsers on different operating systems across multiple platforms. Multi-Output Preview refers to the drop-down menu by which an output can be reviewed prior to publishing. For example, if the template configuration for a page includes publishing as a PDF as well as an HTML file both outputs are available for preview.

Because OU Campus is a decoupled system, server-side code is not executed in the staging environment. Therefore, some items (such as dynamically generated news listings) may not display in the Preview mode. If it is necessary to display the output within OU Campus, additional XSL code must be created to match the production server display.

Previewing a Page
Pages can be previewed in one of two ways:

• From the Pages list view, hover over the page row and, from the Review menu, select Preview.

• When viewing a page, select Preview from the Page Actions toolbar.

Pages can be previewed whether it is checked out to the current user or not, and users can preview files checked out to others. Users are taken to the Preview view after saving a page from the Page Parameters screen, or after saving the page and exiting the WYSIWYG Editor.

Multi-Output Preview
Multi-Output Preview can be used to display the other products that have been configured for the page. Use the drop-down menu next to the file icon to choose the output for preview.
Contributors can preview pages rendered with different file type formats, including HTML, PDF, RTF, CSV, XML, and mobile, as well as any UTF-8 compatible foreign language formats (including two-byte languages such as Chinese and Japanese). If an XSL template is designed to output multiple files, Multi-Output Preview provides the ability to view all different outputs before publishing the page.

For more information, visit the Multi-Output Preview page.

**Multi-Browser Preview**

Users can select different browser and platform combinations to preview before publishing the page, resulting in full-resolution screenshots of the page in each selected browser/platform.

For more information, see the Multi-Browser Preview page.

**Publish Target**

When Multi-Target Publish has been enabled and alternative publish targets defined, then the publish targets can be selected for preview.
Page Check

Overview

Page Check is an account-wide feature with several customization options that can be applied at the account, site, and even user level. Because each check can be turned on and off at various levels in the system, the available options described here may cover more options than are available for an institution's implementation. The four types of checks that comprise Page Check are:

- Spell Check
- Link Check
- W3C Validation
- Accessibility Check

Depending upon configuration, the Page Check can be initiated from Review > Page Check in the Pages list view, while viewing or editing a checked-out page, at the time of publish, or a combination of the above. Some or all of the four quality checks may be enabled to run automatically at the time of publish. This option is called Final Check. A user can also enable Page Check in their individual user settings if an administrator has given all users the ability to enable or disable Page Check for themselves.

If Page Check is disabled, the item does not appear as an option on the Review menu nor is it available when the page is checked out.

At the administrator level, in addition to enabling and disabling each check, administrators can choose the accessibility standard that Accessibility Check uses to perform its check.

Running Page Check

Keep in mind that identified errors for all four options can include issues that are in specific areas on a page that cannot be edited by the user. For instance, if the error is in the header, this is generally only editable by an administrator. In those cases, the user should pass on the identified error to an administrator to have it updated.

From the Pages List View

1. Navigate to Content > Pages and check out the desired page.
2. Hover over the page row and from the Review menu, choose Page Check.

From the Page View

1. When the page is checked out, the Page Check icon is available in the Page Actions toolbar.
2. Click the **Page Check** button.

The **Page Check** modal will appear, where users can choose the output type they would like to check and which checks to run.

1. From the **Page Check** modal, choose the output type to be checked from the drop-down. Only one option may be available, such as HTML, but other outputs may be checked.

2. If necessary, choose the language for **Spell Check**.
3. To choose to run all of the checks, click the **Run All** button.

4. To run each type of check separately, click each individual option to run.
5. After running each check, the item is shown in red if there were errors, warnings, or other issues in the results. The results can be viewed by clicking **Show Results** under the button. The item is shown in green if no errors are found.
6. Click **Done** when finished reviewing the results.

**Final Check**

If, in addition to Page Check, Final Check is enabled (and perhaps even required), then clicking **Publish** will either make the enabled page checks available, or run them automatically.

**Page Check Options**

The four types of checks available for Page Check can be enabled and disabled individually, as well as configured to run automatically upon page publish on an individual basis by an administrator.
## Analyzing Results of the Error Reports

Each of the four types of checks provides reporting of the errors that were discovered. For details about the results of each of the four checks:

- Spell Check
- Link Check
- W3C Validation
- Accessibility Check

## Enabling Page Check in User Settings

Administrators can choose whether Page Check is enabled or disabled for all users at once, or whether users can turn on Page Check themselves. When Page Check is set by users themselves, the currently logged in user can choose to enable Page Check from within their user settings.

1. Hover over the user name in the global navigation bar and choose **Settings** from the menu.
2. Choose **Preferences** from the menu.
3. Click the **Page Check** checkbox.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Spelling Icon" /></td>
<td><strong>Spelling</strong>: Includes the ability to select from five languages that include English, Spanish, French, Italian, or Portuguese.</td>
</tr>
<tr>
<td><img src="image" alt="Links Icon" /></td>
<td><strong>Links</strong>: Link Check checks the links for both internal and external links, identifies any broken links, and provides additional warnings.</td>
</tr>
<tr>
<td><img src="image" alt="W3C Valid Icon" /></td>
<td><strong>W3C Valid</strong>: W3C Validation identifies any W3C compliance issues (both errors and warnings) with a page.</td>
</tr>
<tr>
<td><img src="image" alt="Accessibility Icon" /></td>
<td><strong>Accessibility</strong>: Accessibility Check identifies any issues that may be present relating to the type of accessibility standards configured by an administrator.</td>
</tr>
</tbody>
</table>
4. Click **Save**.

The checks for Page Check that are enabled at the account level are now available for the user.
W3C Validation

Overview

The W3C Validation check identifies any W3C compliance issues with a page. This can assist in determining the validity of web documents. Most web documents are written using markup languages, such as HTML or XHTML. These languages are defined by technical specifications, which usually include a machine-readable formal grammar and vocabulary. The act of checking a document against these constraints is called validation, and this is what W3C Validate does.

Validating web documents is an important step that can dramatically help with improving and ensuring presentation quality. This validator can process documents written in most markup languages. Supported document types include the following:

- HTML5 (when HTML5 Schema for the WYSIWYG Editor is in use)
- HTML (through HTML 4.01)
- XHTML (1.0 and 1.1)
- MathML
- SMIL
- SVG (1.0 and 1.1, including the mobile profiles)

The W3C Valid can also validate web documents written with an SGML or XML DTD, provided they use a proper document type declaration. This validator is also an HTML validating system conforming to International Standard ISO/IEC 15445—HyperText Markup Language, and International Standard ISO 8879—Standard Generalized Markup Language (SGML), which means that in addition to W3C recommendations, it can validate according to these ISO standards.

W3C Validation can be run from the Page Check modal.
Additionally, W3C Validation can be performed from the Final Check modal. Depending upon the configuration, it may run automatically during Final Check; otherwise, it can be selected to run on its own or as part of the Run All option.
Performing a W3C Validation

Users can run W3C Validation from several places in OU Campus. The first method is from the Pages list view:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover on the target page’s row and select Page Check from the Review menu to display the Page Check modal. Alternatively, select Publish from the Publish menu to display the Final Check modal.
3. Click the W3C Valid button to run the check. After the check has finished, users can click Show Results to display the W3C Validation Results modal.

Users can also perform a W3C Validation from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select the page to be edited. Additionally, selecting the page from the File Navigation sidebar also displays a view with the Page Actions toolbar included.
2. Click the **Page Check** button in the Page Actions toolbar to display the **Page Check** modal. Alternatively, click the **Publish** button to display the **Final Check** modal.

3. Click the **W3C Valid** button to run the check. After the check has finished, users can click **Show Results** to display the **W3C Validation Results** modal.

### W3C Validation Results

If the W3C Validation check has completed and there are errors on the page, users can click **Show Results** under the button to display the **W3C Validation Results** modal. This modal includes the following elements:

- **Results**: This field provides a summary of the W3C validation test.
- **Checked By**: The tool used to perform the validation test.
- **Doctype**: The document type of the file being tested.
- **Character Set**: The syntax used in the file being tested.
- **Validation Output**: Provides users with a summary of entries found in the content that either contain w3c errors or warnings.
- **List View**: Provides users with a list view of each error with relevant attached information.

---

![W3C Validation Results](image)

Each item, whether the test identified error items or warning items, will display in the W3C Validation Results modal. Each item identifies a line of code, along with a helper message indicating the problem and a preview of the problem content. In some instances, a solution or additional helper text will be displayed with the item as well.
Spell Check

Overview

Spell Check utilizes the OU Campus global dictionary, as well as the custom site/account dictionaries, to spell check a page. Users can run Spell Check from the Page Check or Final Check modal.

Depending upon how the administrator has configured the site, Spell Check may run automatically as a part of Final Check. For more information about setting up Final Check, please visit the Final Check section of the Publish Settings page.

The Spell Check language may be selected from a drop-down menu with a choice of English, Spanish, French, Italian, or Portuguese.

When errors are encountered, the Spelling button highlights red and displays the number of errors underneath the button. Clicking the number of errors will bring up the Spell Check Results error report. From there, users can view which words were marked as misspelled, the number of instances each word appears on the page, and (if given the ability) add misspelled words to the site dictionary.

Spell Check in the Page Check Modal

![Spell Check in the Page Check Modal](image-url)
Spell Check in the Final Check Modal

Spell Check in the WYSIWYG Editor

Spell Check is also available when using the WYSIWYG Editor, if the option has been made available on the toolbar that is in use. The WYSIWYG Spell Check can be toggled on and off by a user and provides an on-screen indication of misspelled words. The WYSIWYG Spell Check language can be changed by clicking the drop-down menu next to the icon. For information regarding the WYSIWYG spell checker, visit the WYSIWYG Spell Check page.

While Spell Check in the WYSIWYG Editor and in Page Check/Final Check utilize the same dictionary files, Spell Check in the WYSIWYG Editor provides a spell check of the region that is being edited, while a spell check run from Page Check or Final Check checks the entire page. In this way the spell check can detect
additional misspelled words that may be present in an include file or XSL, for example, and also possibly in the different output formats that can be chosen such as HTML or TXT.

<table>
<thead>
<tr>
<th>Spell Check icon in JustEdit toolbar</th>
<th>Spell Check icon in standard WYSIWYG toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Spell Check icon in JustEdit toolbar" /></td>
<td><img src="image2.png" alt="Spell Check icon in standard WYSIWYG toolbar" /></td>
</tr>
<tr>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Spanish</td>
<td>Spanish</td>
</tr>
<tr>
<td>French</td>
<td>French</td>
</tr>
<tr>
<td>Italian</td>
<td>Italian</td>
</tr>
<tr>
<td>Portuguese</td>
<td>Portuguese</td>
</tr>
</tbody>
</table>

**Spell Check Results Modal**

The Spell Check Results modal provides users with a list view of all misspelled words on the currently selected page. Although this modal identifies the errors and allows users to add words to the site dictionary, users must navigate to the WYSIWYG Editor to correct any misspelled words, either by using the WYSIWYG Spell Check tool or manually finding and correcting the words in question.

![Spell Check Results Modal](image3.png)
The ability to add a word to the site dictionary can be enabled for user levels 0 through 8, and if so enabled, the ability to add a word to the dictionary is available by hovering over the row and clicking Add to Dictionary.

<table>
<thead>
<tr>
<th>Word</th>
<th>Instances</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Vegetarian</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Camarillo</td>
<td>1</td>
<td>+ Add to Dictionary</td>
</tr>
<tr>
<td>Angeles</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Multiple words can be added to the site dictionary at the same time by clicking the checkbox next to each word and clicking Add to Dictionary in the table header. When a word has been added, the row will appear in green with a check mark where the checkbox was before.

Performing a Spell Check

There are several methods to performing a Spell Check:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover on the target page’s row and select **Page Check** from the Review menu. Alternatively, select **Publish** from the Publish menu to display the **Final Check** modal.
3. Click the **Spelling** button to display the **Spell Check Results** modal.
4. Add words to the dictionary or go back into the WYSIWYG Editor to fix misspellings if necessary.

Users can also run Spell Check from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting **Content > Pages** from the global navigation bar and select the page to be edited. Alternatively, navigate to the page using the File Navigation sidebar.
2. Click the **Page Check** button in the Page Actions toolbar to display the **Page Check** modal. Alternatively, click the **Publish** button to display the **Final Check** modal.
3. Click the **Spelling** button to display the **Spell Check Results** modal.
4. Add words to the dictionary or go back into the WYSIWYG Editor to fix misspellings if necessary.
Link Check

Overview

Link Check allows users to test all links on a page, both internal and external, and provides information and status codes for these links. Link Check can be run from both Page Check and Final Check.

There are several ways the Link Check can be performed. First, users can access this tool from the Page Check modal. Click the **Links** button to run the check.

Additionally, Link Check may run during Final Check as part of the Publish Process. Depending on how Final Check has been configured, Link Check may run automatically; otherwise, it can be run manually by pressing the **Links** button in the Final Check modal.
Performing a Link Check

There are several ways to perform a Link Check:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover on the target page’s row and select Page Check from the Review menu to display the Page Check modal.
   Additionally, selecting Publish from the Publish menu to display the Final Check modal will also provide the ability to perform a Link Check.
3. Click the Links button to run the check. If desired, click Show Results once the check has completed to view results of the check.

Users can also perform a Link Check from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select the page to be edited.
Additionally, selecting the page from the **File Navigation** sidebar also displays a view with the Page Actions toolbar included.

2. Click the **Page Check** button in the **Page Actions** toolbar to display the **Page Check** modal. Additionally, clicking the **Publish** button displays the **Final Check** modal.

3. Click the **Links** button to run the check. If desired, click **Show Results** once the check has completed to view results of the check.

**Link Check Results**

When users click the Link Check button, it will attempt to validate all on-page links for the selected page, including mailto links. Both staging and production links are spidered.

There are three different indicators that can display after a Link Check has been performed:

![Links icon](image)

**Show Results**

- **OK**

If there are no warnings or errors during the Link Check report, the button is shaded green and the message "OK" displays. This indicates that links are either valid or skipped (by design).

![Links icon](image)

**Show Results**

- 2 warnings

The Link Check button is shaded gold and the message "Warning" with a numerical value indicating the number of potential errors. The system flags a warning for a link when the result of a request for a resource is indeterminate; that is, it did not receive either a positive 202 that the link was OK or a 404 indicating that the file was missing. Other status codes are also possible.

![Links icon](image)

**Show Results**

- 1 error

If the result of a request for a resource there are any errors confirmed by the Link Check report; that is, the result of the request for a file is a client or server error; such as a 404, not found, the Link Check button is shaded red and the number of errors is listed underneath the button.
Show Results
After running Link Check, click Show Results below the button to display the Link Check Results modal. This modal provides a list of the links checked, their status on staging and production, and the applicable status codes. The modal can also be opened in a new window by clicking Open in New Window. The results modal includes the following:

- **Link URL**: Lists the URL or defined href that was requested.
- **Staging**: Indicates the status of the file on the staging server. Hovering over the status icon will reveal a tooltip about the status.
- **Production**: Indicates the status of the file on the production server. Hovering over the status icon will reveal a tooltip about the status.
- **Status Code**: When applicable, provides the response to the request

![Link Check Results - /academics/library.pcf](image)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Staging</td>
<td>Link is not on staging. Indicates that the link is broken on the page in staging.</td>
</tr>
<tr>
<td>i</td>
<td>Production</td>
<td>Cannot check link, all 100 statuses. Link check is unable</td>
</tr>
<tr>
<td>Icon</td>
<td>Column</td>
<td>Meaning</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Staging, Production</strong></td>
</tr>
<tr>
<td>✔</td>
<td>Link is Valid (202), all other 200 statuses. The link points to a page that correctly renders.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Production</strong></td>
</tr>
<tr>
<td>⚠</td>
<td>Moved Permanently (301), Found (302), all other 300 statuses. The file has been moved, or any other miscellaneous issue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Production</strong></td>
</tr>
<tr>
<td>¬</td>
<td>Not Found (404), all other 400 or 500 statuses. The link points to a nonexistent destination (the link has been misspelled, the page has moved, etc.)</td>
<td></td>
</tr>
</tbody>
</table>
**Overview**

The Accessibility Check will check the page's HTML for any issues that conflict with accessibility standards. Administrators in OU Campus can define at the account level which accessibility standard the system uses to check pages.

When run, Accessibility Check will show (at maximum) a list of known problems, likely problems, and potential problems. To view the list of problems, users can click the **Show Results** link under the Accessibility Check button.

There are several ways an Accessibility Check can be performed. First, users can access this tool from the Page Check modal. Simply click the **Accessibility** button to begin the check.

Users can also run the check during Final Check as part of the publish process. Depending upon how Final Check is configured, Accessibility Check may run automatically during Final Check; otherwise, it can be run manually.
An administrator can configure Accessibility Check from **Setup > Account > Publish Settings**. One of the following standards can be chosen, and the results in Accessibility Check will reflect the guideline that was chosen. The default value is WCAG 2.0 (Level AA).

<table>
<thead>
<tr>
<th>Standard</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>WCAG</td>
<td>Web Content Accessibility Guidelines: Includes 1.0, 2.0, and 2.1 specifications for all three priority levels (A–AAA).</td>
</tr>
<tr>
<td>Section 508</td>
<td>USA federal requirements for accessibility standards.</td>
</tr>
<tr>
<td>Stanca Act</td>
<td>Italian requirements for accessibility standards.</td>
</tr>
<tr>
<td>BITV 1.0</td>
<td>German accessibility standards.</td>
</tr>
</tbody>
</table>
Performing an Accessibility Check

There are several ways to perform an Accessibility Check:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover on the target page’s row and select Page Check from the Review menu to display the Page Check modal. Additionally, selecting Publish from the Publish menu to display the Final Check modal will also provide the ability to perform an Accessibility Check.
3. Click the Accessibility button to run the check. If desired, click Show Results once the check has completed to view results of the check.

Users can also perform an Accessibility Check from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select the page to be edited. Additionally, selecting the page from the File Navigation sidebar also displays a view with the Page Actions toolbar included.
2. Click the Page Check button in the Page Actions toolbar to display the Page Check modal. Additionally, clicking the Publish button displays the Final Check modal.
3. Click the Accessibility button to run the check. If desired, click Show Results once the check has completed to view results of the check.

Accessibility Check Results

When users click Show Results after an Accessibility Check has been performed, the Accessibility Check Results modal is displayed. This modal displays a list view of all problems, including potential or likely issues. Each item displayed in the Accessibility Check Results modal includes reference to the exact line in which the errors are found, including the source code and an explanation of the problem. The following categories may be configured for types of errors:

- Known Problems
- Likely Problems
- Potential Problems
- Exceptions

Each problem will contain the exact location of the error in the source code, the name of the issue, a snippet of offending code, and a suggested repair. Clicking the error name will bring up a page containing more in-depth information.
Known Problems

Known problems are problems that have been verified as broken or creating an error. These problems are identified by the red icon next to each list item. If available, a helper message may appear with each list item, helping users identify a solution to repairing the problem.

**Accessibility Check Results - academics/library.pcf**

<table>
<thead>
<tr>
<th>Guideline: 508</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known Problems (9)</td>
</tr>
</tbody>
</table>

**Line: 1 Column: 13770**

**Cause:** script must have a noscript section.

**Source Code:**
```html
<script src="/resources/js/slick.min.js"></script>
```

**Repair:** Add a noscript section immediately following the script that provides the same functionality as the script.
Likely Problems

Likely Problems are items that the OU Campus system identifies as most likely being an error, but is required to be reviewed by a user to designate if the problem is real or not.

<table>
<thead>
<tr>
<th>Guideline: 508</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known Problems (9)</td>
</tr>
</tbody>
</table>

**Line 1 Column 13835**
- **Cause**: Content possibly not readable when stylesheets are removed (SCRIPT).
- **Source Code**: `<script src="/resources/js/jquery.colorbox-min.js"></script>`
- **Repair**: Page is readable when stylesheets are removed.

**Line 1 Column 1038**

[Make Exception]
Potential Problems

Potential Problems are similar to Likely Problems in that they are not verified, but the system has identified code which may or may not cause errors and should be reviewed by a user.

Exceptions

For any of the above checks, a level 10 administrator can make an exception for an error.
An exception can be a known, potential, or likely problem. While it has been identified by the system, it will not prevent page publish, should passing page check be a requirement for publication. When adding an exception from page check results, that exception will be made for every page in the site, not just the current page.

Level 10 administrators can manage exceptions from the account settings.
Versions

Overview

A unique version of a page is saved through the automatic version control system every time a page is published. A backup version of a page can also be created at will with the use of the Save Version button. It can be useful to create a permanent version or backup of the page before extensive editing. It is also important to note that any version descriptions or publish notes added at the time of page publish are shown in the Description column.

All versions of the page are kept in the system until the page is deleted. There is no limit to the number of versions that are stored in the system for an individual page or across all pages in the site. If a file is moved to the Recycle Bin and then restored, versions will still be preserved.

The Versions screen shows this list of saved versions of a page. It can be accessed from the folder structure or while previewing or editing a page. Before navigating from editing a page to viewing versions, the page should be saved.

The Versions screen:

- Shows the number of versions saved for the page
- Shows a sortable list of versions, which includes the revision number for the page, the date it was saved, the page author, the version description given with the save or publish, and other options
- Allows for comparing the current staging version to the current production version
- Provides a method for saving another version of the page
- Allows for reverting to a previous version of the page

Example of Versions Screen

Saving a New Version

Although a unique version of a page is saved in the OU Campus automatic version control system every time a page is published, users can also create a version at any time. For example, after editing and saving
a page several times, a user may wish to create a permanent version or backup of the page before moving on with further edits such as a find and replace. When editing a page, the Save Version button is available for this purpose. The Save Version button is also available in Preview mode.

For more information on saving versions, visit the Save Version page.

Navigating to Versions

From the Folder Structure

The Versions screen can be accessed from the Pages list view of the site.

1. Navigate to the Pages list view and check out the desired page.
2. Hover over Review on the page row and choose Versions. This displays the Versions screen.

From Preview or Edit

The Versions screen can also be accessed while in Preview or Edit mode, or while editing a page with the WYSIWYG Editor. Note that the page must be checked out to the current user.

1. Check out a page and view the page in Preview or Edit mode.
2. While viewing the checked out page, click the Versions button. This displays the Versions screen.

Filtering Versions

The Versions list can be filtered by entering characters in the Filter field. The filter is relevant to the Revision, Author, and Message columns, and items with matching character strings are displayed in the list. The rest are hidden until the filter is removed, which can be accomplished by clicking the circle-x icon. Filtering can be used to help locate a specific version of a page.

Comparing Versions

The compare feature includes the ability to compare different versions of a page. Options of the feature include the capability to show or hide includes and to compare the rendered page or the source code for the page. The current version of the page can be compared with previous version or with the production version. When compared with other versions a source code comparison is rendered and includes files are included.
Comparing with Production Version

1. From the Versions screen click **Compare Current to Live**.

2. The comparison is shown for the rendered page in the default mode. Information about the compare will display above the rendered page.

3. If so desired, click **Hide Includes** to hide any include files that are part of the rendered page.
4. Additionally, if it is required to view a comparison of the source code, click **Source** to view a comparison in source code mode.

Options for Comparing Current Version to Live

Comparing with a Previous Version

1. Locate the previous version that is desired. The different versions can be scrolled through, or a version number may be entered to jump directly to that version.

2. From the Versions screen, navigate to the row for the page version and hover over **Compare**. A user may select from here to compare the page as is, without includes, or in source mode. By default, the page previews with includes. The page comparison view is displayed.

For more information about the color coding in comparing and examples, visit the Compare page.

Sorting Versions

Page versions can also be sorted by clicking any of the available columns:

- **Revision**: The default sort is reverse numerical with revision 1 showing at the bottom of the sorted list
- **Save Date**: Date last saved
- **Author**: Shows the user that performed the page action
- **Message**: Shows the version description text that was entered when the version was saved
- **Options**: Three options are available: View, Compare, and Revert. Additionally, from the view menu a user can choose to view the version of the page or the source of the page version.
**Viewing a Revision**

From the Versions screen, a version of the page can be viewed and the source can be viewed. These views of a page version are provided in a separate browser window or tab. Note that the revision uses the current version of any XSLs that are called. This can cause the viewing of the page version of a previous revision to not display as expected if one or more XSL have been significantly modified.

**Viewing a Page Version**

From the Versions screen, hover over the row for the version and from View, select Page. The page is displayed.
Viewing the Source
From the Versions screen, hover over the row for the version and under View, select Source.

Reverting to a Version
The Versions screen includes the ability to revert to a previous version of a page.

1. From the Versions screen, hover over the row for the version and click Revert.

2. The confirmation dialog is shown.
3. Click **Revert**.
4. A success message shows to which version the page was reverted.

**Note**: The page must be published to the production web server to make it live on the World Wide Web.
Compare

Overview

Within the Versions screen, the Compare feature allows users to compare different versions of a page. Compare allows a user or reviewer (e.g., an approver) to easily identify changes that have been made to a given page by comparing the current version of the page that exists on the staging server to either the page currently on the production server (the last published version of the page), to any prior published versions, or to any version explicitly saved by the Save Version function. Comparing versions is also supported by Multi-Target Publish and a version on a publish target can be selected, if Multi-Target Publish is in use.

Additions, deletions, and format changes of page content are displayed graphically, so that users can easily see what changes have been made across versions.

Versions Screen

The Compare feature is located on the Versions screen, which shows a list of versions of a page. Versions can be accessed in either of two ways:

- From the Pages list view, check out the page. Hover over the page row and from the Review menu, choose Versions.

- Enter the Preview or Edit mode of a checked out page. Click the Versions button in the Page Actions toolbar.

Either method directs the user to the Versions screen, from where users can compare versions. From the versions screen, users can also view previous versions of the page and revert back to previous versions.
Comparing Versions

When comparing versions, OU Campus will compare the current version on the staging server with either the current version on the production server or any other version that exists in the versioning system. When a comparison is made, users can view either the page or source view, and choose whether includes are shown or hidden.

Comparing to Live

1. From the Versions screen click the Compare to Live button. If configured and available, a publish target may be selected by clicking the drop-down arrow on the button.

2. If so desired, click Hide Includes to hide any include files that are part of the rendered page.

3. Additionally, if it is required to view a comparison of the source code, click Source to view a comparison of the source code. If viewing the source, the includes are pulled in automatically.

Comparing with a Previous Version

1. From the Versions screen, hover over the version row item and from the Compare menu, select Page.
2. When comparing the staging version with previous versions, the different versions can be scrolled through or a version number can be entered with which to compare. Users can also hide includes and view the source code of the page, just as with Compare to Live.

Examples and Legends

Production Page

The following table lists the mark-up types and color-coding for comparing to the live production page in page view. For example, text that is shown in red strikethrough indicates text that was deleted. Green underlined text indicates that the text was added. Blue text with a squiggly underline indicates text that underwent a formatting change such as having applied bold or italics to the text.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Color</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deletion</td>
<td>Red</td>
<td>Strikethrough</td>
</tr>
<tr>
<td>Addition</td>
<td>Green</td>
<td>Underlined</td>
</tr>
<tr>
<td>Formatting Change</td>
<td>Blue</td>
<td>Squiggly underline</td>
</tr>
</tbody>
</table>
Example of Live Version Comparison

Version Compare
Comparing current staging version to live production version on publish target gallena-sandbox.

<table>
<thead>
<tr>
<th>Gallena Gophers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admissions</td>
</tr>
<tr>
<td>Undergraduate</td>
</tr>
<tr>
<td>Students</td>
</tr>
<tr>
<td>Graduate Students</td>
</tr>
<tr>
<td>Transfer Students</td>
</tr>
<tr>
<td>TrueCost Calculator</td>
</tr>
<tr>
<td>Request Information</td>
</tr>
</tbody>
</table>

The proud history of the Gallena Gophers dates back to the University's inception in 1897. Gallena University was the first university on the west coast to develop a rowing team, carrying on a proud tradition in university sports programs. Today, Gallena's Athletics program features 17 sports competing at the NCAA Division I level in the Big West Conference.

Athletic endeavors and sports such as baseball, football, and tennis are part of the university's athletic program. Additionally, the university offers every one of its 4,500 students the opportunity to participate in several sports such as volleyball, soccer, and basketball through the intramural program.

Visit our intramurals page to learn more about our various intramural programs.

GU boasts state-of-the-art athletic facilities including a new 40,000-seat stadium and two training/workout facilities. These facilities include an Olympic-sized pool, fully equipped gym, and more. Students and athletes alike are provided with the tools they need to keep them competitive in every sport!

Source and Other Versions
When comparing to the live production server version in source view or when comparing to any other version the markup is slightly different as no blue markup is provided. Any addition of text or formatting change is show in green (not underlined).

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Color</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deletion</td>
<td>Red</td>
<td>Strikethrough</td>
</tr>
<tr>
<td>Addition or Formatting Change</td>
<td>Green</td>
<td>Plain Text</td>
</tr>
</tbody>
</table>
Example of Source Comparison

Version Compare

Comparing current staging version to live production version on publish target gailena-sandbox.

Final Words

Approvers can use this feature when reviewing a page prior to publishing it. The approver (depending on the page’s access settings) can then elect to publish the page, schedule it for publish, send it to another user for review, decline to publish it but keep the changes, which then sends it back to the requester, or decline to publish it and revert to the previous version. This also sends it back to the requester.

If the approver does not have publishing rights, only Send to User and Decline & Keep will be visible.
Publish

Overview

Pages and other content files within OU Campus are located on a staging server. They must be published in order to be viewable on the World Wide Web. By default, all user levels can publish content, but this can be restricted by an administrator with the use of access settings or with an approver workflow. The following items may be on the Publish menu:

- Publish
- Schedule
- Submit for Approval
- Expire

Pages can be published inherently by all user levels. However, it is possible to restrict publishing permissions by assigning an approver. That can also be overridden using the Bypass Approval feature in access settings, whereby the members of a group are given the ability to override the approval process and publish directly. Users can only publish pages to which they have access.

For more information about approvals for publishing content, visit the Submit for Approval page.

Publishing a page is also a method to repurpose content. For example, at the time of a page publish, an RSS feed can be updated or a post can be sent to a connected Facebook or Twitter account. Page publish can include publishing to multiple outputs and alternative publish targets.

Additionally, a Final Check can be set to run before a page can be published. Final Check will perform a series of quality assurance tests on a page before publishing. These include spell checking, link checking, W3C validation, and accessibility compliance.

For more information on this topic, visit the Final Check page.

Binary Files and Publishing

When Binary Management and Dependency Manager are turned on, binary file types also must be published to the production server to be displayed on the live website. For more information about publishing binary files, visit the Binary Management page. Also, see the Binary Management Reference Guide (PDF).

Assets and Publishing

Assets are not viewable on a page until they are published. Depending on access settings, if an approval workflow has been set up for a user, the same process in for publishing a page will be required.

For more information, visit the Publishing Assets page.
"Unpublishing" a File: About Recycle, Delete, and Restore

To remove content from being published live on a site, pages and files must be moved to the Recycle Bin. By default, only administrators and Level 8 users can recycle and delete files, pages, directories, and assets. Administrators can also give Level 1–7 users the ability to recycle and delete files and directories. User levels 1-8 can only recycle and delete files to which they have access.

Pages that are moved to the Recycle Bin can be restored, if necessary. When a page is recycled on the staging server, the published derivatives are automatically removed from production servers. Once a page is deleted from Recycle Bin or a folder is deleted, it can no longer be retrieved.

Pages and directories on the production server can only be permanently deleted. When pages and directories are deleted, it is no longer capable of being restored. Content deleted from the production server will still exist on the staging server, and can be re-published from there for viewing on the live site. This will place the file back on the production server.

For more information, visit the Recycle Bin page.

Once initiated, a publish action cannot be interrupted or stopped. However, a scheduled publish can be removed before it is scheduled to happen. Alternatively, a page can be reverted to a previous version to effectively "undo" the publish.
Publishing a Page

Overview

When publishing a page, either from the Publish button in the Page Actions toolbar or from Publish > Publish in the Pages list view, the Publish modal appears.
Publish - future_studentspcf

Scan your page for spelling, link, W3C validation, and accessibility issues. Run all checks, or run individually by clicking the button.

htm  Run All

Spell Check Language

English

No errors found.  Show Results

OK

Publish Target

Production

Version

Description

0/256

Cancel  Publish
Keep in mind that content can be "published" in other manners as well, such as with a find and replace action, directory or site publish, an expire, triggered publish, upload to the production server, or via a template that automatically publishes specific files upon initial creation.

The publish modal can be reached in one of two ways:

• By checking out a page in the Pages list view, hovering over the row, and clicking **Publish** from the Publish menu.

  ![Publish Modal](image)

  Multiple pages can be published at once by selecting each page's checkbox in the Pages list view (or the Select All checkbox in the table header) and clicking the **Publish** button in the table header. If a page is checked out by another user, the row will not have a checkbox and therefore will unable to be published.

  ![Multiple Pages](image)

**Publish Modal Reference**

**Final Check Tab**

This tab is where users can run Final Check before publishing the page, as well as select the output and publish target, and enter in a version description.

• **Output Selector**: If more than one output is created by the template configuration (e.g., both an HTML page and a CSV are created) and the alternate is a type on which the checks can be run, the selector can be used.

• **Run All**: Click to run all available checks on the selected output. See **Final Check**.

• **Spell Check Language**: The default language (as determined by the Locale setting) for the spell check dictionary is shown, but a different dictionary can be selected by which to run the spell check against.

• **Spelling**: Checks the spelling on a page in the given language selected in the Spell Check Language box.
• **Links**: Checks for broken links on the page. Links may be broken due to unpublished dependencies. See Include Unpublished Dependencies below.

• **W3C Valid**: Checks a page for valid HTML and XHTML markup, depending on the schema setting.

• **Accessibility**: Checks the accessibility of a page complies to the standard defined by an administrator (i.e., WCAG, Section 508, Stanca Act, or BITV).

• **Publish Target**: If available, a publish target other than the production server may be selected.

• **Include Unpublished Dependencies**: This checkbox allows a user to publish all unpublished dependencies for the page at the time of publish. When enabled, the Dependency Manager reports at the time of page publish if there is dependent content (e.g., images or documents) that has not been published to the target server (i.e., has been uploaded to staging but not published yet). This prevents broken links and images from occurring on the current page being published. This option only works if Dependency Manager is enabled, dependency tags are being used on the page being published, and one or more of the dependency tags in use refer to files that have not been published to the current target.

• **Version Description**: This will allow users to enter a version description to be included in order to indicate what was updated and why the page is being published. Upon publish, this information is viewable in the page’s **Versions** screen. For more information, visit the **Versions** page.

**Schedule Tab**

This tab allows a page to be published at a future date and time. Pages can be set to repeat publish and have a message sent to the user’s internal Inbox as well as their external email account. For more information, visit the **Schedule** page.

**Social Media Tab**

This tab allows users to send a tweet or Facebook post to a linked Twitter or Facebook account when a page is published. A shortened URL linking to the newly-published page can be added by clicking the **Add URL** checkbox beneath the respective social media fields.

• **Twitter**: If one or more Twitter accounts have been configured, the system sends a tweet to the selected Twitter accounts upon publish. A shortened URL can be added that directs to the published page. Tweets may be up to 280 characters in length. Default text can be configured at the account and/or site level and edited at the time of publish.

• **Facebook**: If one or more Facebook pages have been configured, the system sends a post to the selected Facebook pages upon publish. A user may add a shortened URL that directs to the published page. Posts may be up to 420 characters in length. Default text can be configured at the account and/or site level and edited at the time of publish.

After configuring the options, click the **Publish** to finalize the action.

**Selecting a Publish Target**

If Multi-Target Publish has been enabled for the site and multiple publish targets exist, users with the proper access rights can select which publish target to which they want to publish through the drop-down menu.
For more information regarding Multi-Target Publish, please visit the Publish Targets page.
Final Check

Overview

Final Check gives a user the capability to perform a series of quality assurance tests on a page before publishing. These include spell checking, link checking, W3C validation, and/or accessibility compliance. An administrator can configure the options, if any, to auto-run when an OU Campus user publishes a page. Even if Final Check is not configured to run automatically at the time of publish, the site may be configured so that a user may manually run any enabled checks.

The available Final Check options are based on the activated Page Check options. For more information about the four checks that comprise Page Check, visit the Page Check page.

Running Final Check

Final Check can be configured in one of two ways:

• To run some or all of the activated checks when the Publish button is clicked.
• To allow users to choose which page checks, if any, to run when the Publish button is clicked.

If Final Check is configured to automatically run at the time of publish, the scan will be performed prior to completing the publish. The page cannot be published while the checks are running.

If Final Check is not configured to run automatically, click Run All to run all checks, or click any of the enabled checks to selectively run checks.

Once the checks have completed, users can click any of the Show Results links below each check to view the results. It is strongly advised that the errors be resolved prior to publishing the page. Note that the identification of errors, warnings, or problems do not prevent the page from being published.
**Enforcing Final Check**

Final Check can be enforced from **Setup > Sites > Site Settings > Publish Settings**. By checking this, the admin ensures that Final Check must be run before a page can be published. It can be additionally enforced to ensure that if a page does not pass Final Check, it cannot be published or scheduled to publish until the errors are corrected.

If Final Check has been enforced and the enforced checks return any errors, then the **Publish** and **Schedule** buttons will not enable until the errors are corrected. An error message will also display, notifying the user that Final Check has not passed. Level 9 and 10 administrators, however, have the ability to bypass this and still publish the page.
For information on how to configure this setting, visit the Publish Settings page.
Schedule

Overview

Users have the ability to publish content at a later date using the Scheduled Publish tool. A scheduled publish can only be canceled or modified by the user who set the schedule, or a Level 9 or 10 administrator. If a new RSS item has been added to a page, but not yet published, the RSS item is added to the feed and the feed is rebuilt with a new page publish. Pages can be scheduled to publish either from the Schedule Publish tab inside the Publish modal, or by selecting Schedule from the Publish menu in the Pages list view.

Additionally, users can schedule a publish by clicking Schedule from the drop-down menu of the Publish button in the Page Actions Toolbar.

Schedule Tab

When users select the Schedule tab of the Publish modal, the following elements are displayed:

- **Date:** The target date the user wants the page to publish on.
- **Time:** The time at which the scheduled publish will take place.
- **Repeat Every:** Allows users to repeat the publish by specific amounts of time using the text field and drop-down selector.
- **Subject:** Optionally, users can send an external email in addition to the internal OU Campus message. This field lets users add a subject line to that email.
- **Message:** Allows users to include a brief message about the publish in an external email.
- **Send Copy to Email:** If selected, the option sends an external email to the user in addition to the internal OU Campus message.
After a scheduled publish has been performed, the status of the content will change in the Pages list view. A green calendar icon indicates that the page is checked out to the current user because the user has scheduled a publish to occur. Other users' scheduled publishes will appear as red calendar icons.
Performing a Scheduled Publish

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover over the target item's row and select Schedule from the Publish menu. Users can also navigate to a view that displays the Page Actions toolbar and select Schedule from the drop-down menu on the Publish button to accomplish this.
3. Click in the Date text field to display a calendar widget and select a date. Users can scroll through the months of the calendar using the arrows at the top of the calendar.
4. Click in the Time text field to display a time selector and set the target date for the publish.
5. In the Notification section, fill out the Subject and Message fields and choose whether to send an email to the user's external email account using the Send External Email checkbox.
6. If preferred, switch to the Final Check tab and run any tests necessary before publishing.
7. Click Schedule.

When the page is published, the user who scheduled the page will receive a notification in their Inbox as well as in their email inbox (if an external email was configured to send).

Note: During peak hours, the scheduled publish server may receive a large amount of requests at one time. As a result, it may take several minutes longer to complete the scheduled publish than the time defined in OU Campus.

If a scheduled publish fails, users will receive a failure message either via email or inside the Inbox, and OU Campus will attempt again at the next available time interval (which occur every 15 minutes). If the publish is attempted three or more times and still fails, the scheduled publish will be automatically removed and another message will be sent to the user.

Removing a Scheduled Publish

A scheduled publish can also be removed from a page or file. A user is unable to immediately publish content that is already scheduled for publishing at a later date until the scheduled publish assignment is removed.

To remove a scheduled publish:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Click the green calendar icon on the target item's row to display the Remove Scheduled Publish modal. Alternatively, navigate to the page and click the Remove Scheduled Publish button in the Page Actions toolbar bring up the modal.
3. Review the details in the Remove Scheduled Publish modal and click Remove to remove the scheduled publish. The page is now checked out to the current user and can be immediately published if desired.
Submit for Approval

Overview

Administrators have the ability to enable an approval workflow for users. This requires all content from users to be submitted to an assigned approver before the page is published. The approver will then have the option to Publish or Decline the page.

In order to submit for approval, content must be checked out by the user. If the user is in a workflow and restricted from doing a direct publish, they will see a Submit button in the Page Actions toolbar instead of a Publish button.

Users level 4 and greater can still submit content edits for approval, even if an approval workflow has not been created for the user.

When a page is submitted for an approval, the page will automatically be checked out to the approver. The Pending Approval status will show in both the user and approver’s Workflow.

After the Submit for Approval button is clicked, the Submit for Approval modal appears. It includes the following items:

- **To**: Users select an approver from the drop-down to send the content for review. If the approver is enforced, then the drop-down is unavailable and the content must be sent to the enforced approver.
- **Subject (required)**: A brief subject used to help identify the file for review.
- **Message (optional)**: Users enter a brief description in the text field to help approvers identify the changes that have been made.
- **Send Copy to Email**: Sends an email to the approver’s external email address in addition to the internal OU Campus message received in the approver’s Inbox.

After this information has been entered, click Submit to submit the content for approval.
Sending for Approval

Both pages and binary files can utilize the approval workflow.

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar. Additionally, expanding the File Navigation sidebar displays a list of the available pages.
2. Select a page from the Pages list view and hover over the row. Choose Submit For Approval from the Publish menu.
   Alternatively, clicking the linked file name from the list view or the sidebar will display the page and the Page Actions toolbar. From the toolbar, click the arrow on the Publish button to reveal additional publishing options including Submit For Approval.
3. Select the user from the drop-down next to the To field. If an approver has been enforced, the To field is auto-populated and there will not be a drop-down available.

4. Fill out the necessary text fields.

5. Optionally, select **Send Copy to Email** to allow the request for review to be sent to the user’s external email address. This allows users to receive a notification that action is to be completed, without having to log into OU Campus. Clearing this option will only send the message through the OU Campus system.

6. Click **Submit**.

For more information about approving content, please visit the **Approving** page.

**Workflow 101 Video**

Workflow 101 from OU Campus Training on Vimeo.
New Content

Overview

Content can created and managed within the Pages list view of the CMS. By navigating to **Content > Pages**, a user with the proper authority may create new pages, sections, folders, and other types of content. The system is configured with templates, which are utilized to create new sections and pages. These templates allow for the pages to be configured uniformly and have a consistent look and feel. The available templates depend upon the structure created by the administrators.

For more information about setting up templates, please see the **Templates** page.

The templates available for creating new content are dependent upon the implementation and the access settings as configured. Templates are specific to the institution, and examples given may vary from new page to new page, as well as from institution to institution. Note that the template choices below are examples and may not be the same template options offered by the institution, and do not include every conceivable template. Also, different sets of templates may be available in different folders.

New Folder vs. New Section

The difference between creating a new folder and creating a new section is that when creating a new section, the template can be configured to create new pages as well. The basic **New Folder** tool generally should not be used to create new directories that will contain web pages, as the support files needed by the page XSLs are not created when using the New Folder option, leading to error messages when a user attempts to publish.

The most common use of the New Folder option is when users need a directory to contain images, PDFs, Word docs, or other non-web page files. For this reason, it is generally recommended to use template groups to allow administrators to repress the ability to create a new empty folder, as often times users can become confused between the basic (built-in) New Folder tool and New Section templates (which create folders and files).
Creating New Content

New pages and directories can be created by clicking the **New** button or the drop-down indicator next to **New** from the Pages list view.

The same options are available whether users click the New button or click the drop-down indicator. When a template is clicked, a modal will appear with the fields necessary to configure the new content.

**Example of New Content Drop-Down Menu**
An implementation will typically include at a minimum:

- Create a **New Folder**. Folders are for binary files and are not the same as creating a new directory. A folder can be created to contain binary files, such as images and PDFs. For more information, visit the Creating a New Folder page.
- Create a **New Section**. The New Section option creates a new content-based directory. The new section template will contain all of the necessary files to make the pages within the new directory render correctly.
When creating a new section, navigate to the parent directory where the new section will be contained. If New Section does not appear, contact the administrator.
For more information, visit the Creating a New Section page.

- Create a New Page. A new page can be created by clicking on the appropriate template for the type of page. Note that administrators can restrict the type of templates available for the directory, and that users may not have a choice in template type.
  For more information, visit the Creating a New Page page.

Many implementations contain additional templates that are meant to be used in specific cases or places within the site, such as a blog or faculty directory. Examples of these templates can be found on the Other Templates page.
Creating a New Page

Overview

A new page can be created from existing templates within the OU Campus system by accessing the Pages list view. The Pages list view can be accessed by selecting Content > Pages from the global navigation bar. Not all users have the authority to create new pages, and users with authority to create new pages may have restricted access to the type of template that may be used. Users have access to the following screens during the new page creation process:

- **New Content Modal (or drop-down menu)**: Allows users to choose from the available templates to create a new piece of content.
- **New Page Modal**: This modal appears after a template has been selected and contains the fields necessary for page creation (including filename, basic metadata, page parameters, and custom template options).

New Page Creation Options

A new page can be created from the Pages list view by clicking the New button. The New Content modal will appear, and you will see a range of available templates to choose from. These templates will be unique to your implementation, and depending on file setup and access settings, may vary from folder to folder as well.
Users can click one of the template icons to open the New Page modal for a new page using the selected template. The New Content modal includes:

- **Template Icon**: Provides users a thumbnail icon, usually depicting the functionality of the template associated with the image.
- **Template Name**: Provides the name of the template (or the template’s file name) as it appears in the OU Campus system.

Users can additionally click the drop-down indicator on the **New** button to display the available templates.
New Page Modal

After users select the template to use for the new page creation process, the New Page modal displays. This is also referred to as the New Page Wizard. The options available on this modal are directly dependent upon the options defined in the template design files and the XSL. Users fill out all necessary parameters in this modal to create a basic page, usually without adding content at this stage. Page content is added later by the user with the WYSIWYG Editor.
Creating a New Page

To create a new page in OU Campus:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Click the New button, or use the drop-down menu.
3. Select the type of page to be created.
4. Fill out the New Page information in the displayed modal.
5. When the information is completed, click Create.
Creating a New Page Video

Creating a New Page in OU Campus from OU Campus Training on Vimeo.
Upload and Edit Image

Overview
An image can be edited and uploaded in one process from the Upload modal within the Pages list view of OU Campus, or when a user is browsing for a file in the Select Image filechooser.

Selecting and Uploading the Image
The ability to Upload and Edit can be found in two places:

- From the Pages list view, click the Upload button. For Upload Type, choose Upload and Edit Image.

- While inside the WYSIWYG Editor, click the Insert/Edit Image button and browse for a file. In the Select Image modal, click the drop-down next to Upload and select Upload and Edit.
Once either of the above steps has been completed, proceed as follows:

1. Select the image file from the local hard drive for uploading and editing.
2. This displays the **Edit Image** screen for the image.
3. After editing the image as necessary, click **Upload**.
4. Enter a filename for the image in the **Save As** modal. When **Save** is clicked, the image will be uploaded onto the staging server, where it can then be published to the production server or publish target.
Editing the Image

From the Edit Image screen, the following functionality is available in the Tools menu:

- Resize
- Crop
- Rotate
- Zoom
- Undo
- Redo

As the image is edited, an estimated file size is shown underneath the image panel. This size will change as the image is resized and cropped.

To learn more about the tools available in the Image Editor, visit the Image Editor Tools section of the Image Editor page.
Creating Assets

Overview

The basic steps for creating an asset are the same for all assets types. Inherently, users levels 4 through 10 have the ability to create a new asset, but this can be modified with various access settings. Depending upon the asset type being created, the available fields and options will vary. Once an asset has been created, it is available for inserting onto a page via the WYSIWYG Editor or Source Editor in accordance with any access settings that may be configured.

Click the New button to create a new asset. The following panels are available:

- **Asset Info**: Configures basic metadata properties.
- **Access Settings**: Allows for the initial initial group assignment to be made for editing and using the asset. Approver/workflow access settings can be configured after creation.
- **Asset Content**: Allows users to create the content within the asset.

LDP is an optional set of features in OU Campus that require specific configuration by an administrator. The Forms and Image Gallery assets are not available on the New menu unless Live Delivery Platform has been purchased and activated both at the account level and the site level. Please contact the university’s designated OmniUpdate Sales Director for details.

Creating a New Asset

To create a new asset in the account:

1. Navigate to the Assets list view by selecting **Content > Assets** from the global navigation bar.
2. Click the New button or the down-arrow on the New button.
3. Select the asset type from the menu that appears, whether it is the dropdown or a new modal.
1. Configure the necessary settings.
2. Click Create.
3. Publish the asset. An asset must be published to the production server or publish target to update content on pages. An asset may be inserted on a page without publishing, but the content will not update the page on the web server. After using the asset on a page, the page must be published to update live version of the page.

**Asset Info Panel**

The Asset Info panel allows users to configure basic metadata properties of an asset. The following are displayed in the Asset Info panel:

- **Asset Name**: Friendly name that will be displayed through the whole system.
- **Description**: The description can also be useful as it is shown when selecting an assets from the Asset Browser when hovering over an asset.
- **Tags**: Tags can be added during asset creation or editing. Tags can be utilized by users to filter a list of assets.
- **Lock to Site**: Select the checkbox to disallow use of the asset outside of the site. Form and Image Gallery assets are always locked to the current site. In other words, assets are available to all sites within an account unless this checkbox is selected.
Access Settings Panel
The Access Settings panel allows users to configure the access settings for editing and using the asset, and is available for user levels 8 through 10. The Access Settings panel contains the following items:

- **Access Group**: Assigns an access group to the asset. "Everyone," the default group, indicates that every user within the account can edit the asset from the Access screen.
- **Available To**: Assigns an access group whose members can use (insert on a page) the asset. Everyone, the default, indicates that every user within the account can insert the asset into a page via the WYSIWYG Editor or the Source Editor.

After the asset has been saved, the additional settings include Approver, Enforce Approver, and Bypass Approval, and those can be configured via the assets action view in the Properties menu.

Asset Content Panel
The Asset Content panel is available for Web Content Assets, Source Code Assets, and Text Assets, and allows users to create the actual content of the asset. The available functionality of this panel depends upon asset type. Image Galleries and Forms do not have this panel displayed.
Inserting Assets

Overview

In order to insert an asset into a page or editable region, it must first be created within a site in the OU Campus system.

For more information about creating assets, visit the Creating Assets page.

Once assets have been created, end-users can utilize assets. Assets are commonly inserted by one of the following methods:

- Using the WYSIWYG Editor
- Using an Asset only region
- Using the Source Editor

Inserting an Asset with the WYSIWYG Editor

Most often, an asset will be available to insert on a page while editing in the WYSIWYG Editor. Content editing might also be configured so that when clicking on an editable region button, the user is only presented with an asset chooser. Once a page has subscribed to the asset, any changes in the asset will update the page and republish it. The republishing of pages subscribed to assets can be throttled by administrators with the configuration of the publish threshold setting.

1. While in the WYSIWYG Editor, place the cursor where the asset will be entered.
2. Then find and click on the Insert Asset icon in the toolbar.

3. From the Asset Browser, choose the asset from the list of available assets. Optionally, a user can filter the list by tag, type, or site. Assets from all sites within an account are shown unless otherwise restricted. Form Assets, which are site specific, are also only shown in the site in which they were created.
4. Click on **Select Asset**.

The asset will be entered into the page where the cursor was placed. If the asset is a Text Only Asset, or a Web Content Asset with no block level HTML code (such as p or div tags), the asset will preview with the content inside of a wrapper.

If the asset is a Web Content Asset with block level HTML code, a Source Code Asset, an Image Gallery Asset, or a Managed Form Asset, it cannot be previewed in the WYSIWYG Editor, but it will still have a wrapper. Note that even though the asset is not displayed in the WYSIWYG Editor, most will still render in the page preview. Source Code Assets will not always render with preview.

To delete an asset from a page in the WYSIWYG Editor, click anywhere on the asset wrapping and press the Delete key.

**Inserting an Asset Only Region**

An administrator may also create a template file that displays an editable region which forces users to use an asset chooser.

1. Click on **Choose an Asset** when creating a new page or in the MultiEdit screen, or simply the **Edit** button in an editable region.
2. Search for the desired asset using the filter options. Assets from all sites will appear, except for Managed Form Assets, which are site specific.
3. Select the desired asset.
4. Click **Select**.
Inserting an Asset with the Source Editor

A user can add an asset to a page or editable region using multiple methods including the Source Editor. It is important to remember that only Level 10 and Level 9 administrators have access to the Source Editor in the OU Campus system. However, lower level users can have access to the Source Editor as well as long as an administrator has enabled this functionality for the user's account in their permission settings.

1. Navigate to the pages list view by selecting Content > Pages from the global navigation bar. Hover over the row for the target page and select Edit from the list of available actions.
2. While in the Source Editor, place the cursor where the asset will be entered. Then click Insert from the available toolbar.
3. After clicking the icon, the Insert Asset modal is displayed.

The Insert Asset dialog contains a list of the available assets along with a preview of the asset's content. The available list can be filtered by tag, type, or site.

4. Select the asset to be used.
5. Click Insert. The asset tag is entered into the source code where the cursor was placed.

Assets in source code follow the syntax {{a:###}}, where the ### denotes the asset number. If an asset number that does not exist is entered, the asset does not render.
Dashboard

Overview

The OU Campus Dashboard provides a location within the CMS where each individual user can access user-specific messaging and gadgets. The Dashboard is the default log-in location from the standard OU Campus Login screen when not utilizing DirectEdit.

In the Dashboard menu on the global navigation bar, users can find links to Workflow and Inbox. These options are also found beneath the user's name on the Dashboard overview page.

The Dashboard can be customized by each individual user by choosing which gadgets to show or hide in the view. A level 10 administrator can add gadgets to the system, and then make them available using group access controls.
Dragging Dashboard Gadgets

Gadgets can also be reordered on the Dashboard by clicking and dragging the grey title bar to a new "tile," shown by a dotted line.
There are three options on the Dashboard menu in the global navigation bar:

**Overview**
Clicking Overview takes users to the Dashboard overview page (seen above). Simply clicking the Dashboard link in the global navigation bar will take users to the same location.

**Workflow**
The Workflow list view shows content that a user has sent to another user for approval or content that has been sent to the current user for approval. These messages are separate from other messages (which can be viewed in Inbox and Sent). Content moving through an approval process can be tracked using this screen.

For more information, visit the Workflow page.

**Inbox**
Inbox displays messages from other users as well as automated messages associated with scheduled actions, such as a notification of scheduled publish or notification of page expiration. The Inbox Gadget is also shown on the Dashboard and includes how many new messages are in the inbox. The Inbox includes a linked list of messages and the functionality to compose a message.

For more information, visit the Inbox page.

Additionally, the Dashboard itself includes more functionality:

**Configure Dashboard**
Configure Dashboard can be used by each individual user to choose which gadgets to show in the main content area. For more information, visit the Configure Dashboard page.

**Gadgets**
Frequently displayed gadgets include Inbox for messaging, site analytics, and the My Checked-Out Content Gadget, which lists all content that is currently checked out by the user.

For more information, visit the Gadgets page.
Workflow

Overview

The Workflow screen allows users to track content that has been sent for review through the approval process. The Workflow list view shows content that the current user has submitted to another user or received from another user. Additionally, content that has passed through or completed a workflow process (such as when content was approved and published, the request was declined, or canceled) is also shown in this view.

Workflow can be found in the global navigation Bar at Dashboard > Workflow or by clicking the Workflow link near the user's name on the Dashboard page.

When an administrator configures access settings for a page, users editing the page may be required to submit their changes to an approver in order for the content to be published. When this is the case, the Publish button on the page will be replaced with the Submit button. Users can include a message to the approver along with the submission. These messages, along with a link to the content, appear in the approver's Workflow list view.

Messages not attached to approvals that are sent to the user's account will not be found in the Workflow. They are available in the Inbox.

Level 9 and Level 10 administrators may view the Pending Approvals report to view all content in workflow across all users.

Workflow Screen

The Workflow screen includes the following features and functionality:

- The number of items in the Workflow. Each item is not an individual message, but rather all the activities associated with a specific file
- Filter tool to narrow down visible results in the list view
- Selection checkboxes to select and delete multiple messages at a time, or to view a single workflow item
- Sortable columns in the list view. Messages can be sorted by From, Approver, File, Status, or Date
- The linked file name which can be clicked to preview the content
• Status icons indicated where the page is in the workflow process
• The date and time that the content was last sent for approval

**File**

The approver can click the linked file name to preview the content. Content that is sent to an approver is automatically checked out to that user and the user can perform various actions on the content, including decline and revert. For example, if the content is an image, clicking the link in Workflow will bring up the Image Editor. If the content is a page, the preview of the page is shown. Please note that Level 0 Reviewers cannot edit files.

**Status**

A status icon is shown in the Status column for each content item. Content listed in Workflow can be previewed by any user, but only the user to whom the content was sent has the file checked out and can perform other actions upon it. Clicking a status icons shows the Workflow Message.

<table>
<thead>
<tr>
<th>Status Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pending Approval (by another user)" /></td>
<td>Pending Approval (by another user)</td>
</tr>
<tr>
<td><img src="image" alt="Pending Approval (by the current user)" /></td>
<td>Pending Approval (by the current user)</td>
</tr>
<tr>
<td><img src="image" alt="Approved and Published" /></td>
<td>Approved and Published</td>
</tr>
<tr>
<td><img src="image" alt="Declined" /></td>
<td>Declined</td>
</tr>
<tr>
<td><img src="image" alt="Cancelled from Workflow" /></td>
<td>Cancelled from Workflow</td>
</tr>
</tbody>
</table>
View
Within each item, there may be multiple actions. Every time a file is sent for approval, the sender can also attach a message. There are several ways to view the actions and messages associated with each Workflow item:

• Hovering over the file row and clicking on the View option
• Clicking the Status icon
• Selecting the checkbox next to the item and clicking View

From within the View Messages screen, users can:

• Click the linked file to preview the content sent for approval
• View the status of the file (i.e. pending approval, declined, etc.) and the time at which the status was last changed
• View all public messages in the workflow, as well as any private messages sent or received by the user, and the time at which the messages were sent
• Write a new message
• Navigate back to Workflow

New Messages
Users can write a new message in the text field at the top of the messages section. Messages may be either public or private. A public message is visible to all users involved in the workflow, while a private message
is visible to only the user who sent it and the user who received it. To set a message as private, select the desired user from the dropdown list. Private messages will be highlighted in yellow.

Messages are by default the same privacy setting as the previous one in the workflow; i.e., a message responding to a public message will by default also be public, but can of course be changed.

The initial submission for approval and the resolution of the workflow item (e.g. publish, decline) will always be public.

**Archive**

Once a workflow item has been resolved, it may be archived in one of the following ways:

- Hovering over the file row and clicking **Archive**
- Clicking **Archive** in the Workflow Message view
- Selecting the checkbox next to the item or multiple items and clicking **Archive**

Items are archived on a per-user basis. For example, if Anna and Bob are both part of a workflow message, and Anna archives it once the page has been published, Bob will still be able to see the item in his own workflow. Once every user associated with a workflow item has archived said item, it will be deleted from the database after a period of several years. Once archived, items cannot be restored.

**Note:** Items that are pending approval by another user cannot be archived.
Inbox

Overview

OU Campus has an internal messaging system that allows users to send messages to other users and groups of users. These messages can be attached to requests for approval as part of the Workflow process, or they can be sent to users without associating them with a page. All messages can have a copy sent to a user’s email address in addition to being sent internally in OU Campus.

All workflow-related messages reside in a separate section of the Mailbox. For more information, visit the Workflow page.

All other messages reside in the Inbox section, with the ability to compose, reply, forward, and delete messages, as well as view sent messages in the Sent section.

The Inbox is similar to a standard email inbox. Users can navigate to the Inbox from the Dashboard menu in the global navigation bar or by clicking the link to the Inbox on the Dashboard itself.

Inbox messages can be also be previewed from the Dashboard through the Inbox Gadget. Clicking a message in the gadget will take users to the message in the normal Inbox interface.

Composing Messages

Compose is found in the Inbox and in the Sent box. By default, the Send a Copy by Email checkbox is selected. This will send an email with the composed message to the recipient’s external email account, as
long as the user receiving the message has an email address on file. If no email address is on file, it will only send the message within OU Campus.

To compose a message:

1. Navigate to the **Inbox** or **Sent** box.
2. Click on the **Compose** button, found in the top right of either screen.
3. A modal will appear. Enter the user to whom the message should be sent in the **To** field. A user or a group of users may be selected from the drop-down, which appears when the user clicks into the field.
4. Enter a 
   **Subject**
   and
   **Message**

5. By default, the **Send a copy by email** checkbox is selected. To only send the message within OU Campus, uncheck this checkbox.
6. When the message is complete, click **Send**.

**Viewing, Replying to, and Deleting Messages**

To view a message on the Inbox screen, hover over the message row and click View, or click the hyperlinked message subject. From the gadget, click anywhere on the desired message to enter the message view in the Inbox screen.

Use the blue **Reply** button in the page footer to reply to the message, or click the **Forward** button to forward the message to another user. A user can return to the Inbox without responding to or deleting the message by clicking the **Back to Inbox** button in the footer or the Inbox button in the local navigation bar on the left.

A message may be deleted by hovering over the message row in the Inbox list view and clicking **Delete**. Multiple messages may be deleted by selecting the checkbox next to each message and clicking the **Delete** icon that appears in the top row.
Multiple messages can also be marked as Read (such as when a user has received multiple messages notifying of successful publishes). To do so, simply select each message and click the **Mark as Read** icon that appears in the top row.

**Sent**

The Sent list view shows messages that the user has sent and messages that were sent in association with scheduled publishes, reminders, and the workflow process. If a message that has been sent to the user is replied to or forwarded, then that is also shown on the Sent screen.

Other functionality available from the Sent screen includes:

- A list of the number of sent messages
- A filter tool to narrow results by the recipient or the subject
- A Compose button to immediately compose a new message
- Columns that are sortable by recipient, subject, or date
- Multi-select checkboxes to delete multiple messages at one time
- The ability to review, reply, forward, and delete messages from the Sent view
- Items that can be hovered over in the list view, allowing users to view or delete individual messages

**Forwarding a Message**

Users can forward previously sent messages to other users and groups.
To forward a message:

1. From the Sent screen, Click the Subject column of the desired message. Alternatively, hover over the message and click View.
2. Click Forward in the footer and fill in the To field with the desired recipients. Modify the Subject and Message fields as necessary.
3. By default, a copy will be sent via external email. If the user does not have an external email associated with their account, then the message is only sent within the CMS.
4. Click Send.
Gadgets

Overview
A gadget is a little program that provides additional functionality or streamlined access to functionality within OU Campus. Gadgets are available account-wide and can be either a system gadget or a custom-created gadget. System gadgets are included with the CMS. Gadgets customized for an institution are also integrated into the implementation. Gadgets may also be created after the initial implementation and added to the system. In any event, gadget access may be limited by group assignment and members of the group (and administrators) will have access to that particular gadget. Some gadgets are only located on the Dashboard or on the Gadgets sidebar, while others are available in both locations.

Each individual user can choose which gadgets to show or hide on their Dashboard or Gadgets sidebar; some gadgets are context-specific, meaning that they will only appear when viewing a page or inside an editable region. These include the Page Info Gadget, Images Gadget, Snippets Gadget, and YouTube Gadget.

When new system gadgets are added into OU Campus with new version releases, they will need to be activated in OU Marketplace. Visit the Marketplace page for more information.

Administrator-created gadgets have access to the OU Campus API, so they can be programmed to do virtually anything a built-in tool can do, plus can additionally be scripted to access other external web services. Gadget files are created in a directory that consists of, at a minimum, an XML file to configure the appearance of the gadget, and a URL (i.e., index.html) that includes the program. The gadget code can include JavaScript, jQuery, HTML, and CSS, both in the form of imported files and within the page itself.

Custom-created gadget functionality includes but is by no means limited to:

- Bulk assigning a user to groups
- A chat client for in-system, real-time messaging
- A color picker that can be used to visually choose a color and then insert the hexadecimal equivalent into code
- Inserting an image from Flickr
- Sending an email from the Gadgets sidebar
- Quickly publishing a page
- Providing a user list
- Programmatically modifying PCF files
- Automating repetitive tasks

Video

Gadget Configuration
Gadget access is controlled by a Level 10 administrator from the Setup > Gadgets screen. This screen allows the administrator to assign groups to each gadget, giving group members the ability to view and use the gadgets. In addition to being able to assign gadget access, an administrator can create new gadgets and configure gadget-specific properties.

For more information, visit the Gadgets Setup page.
Dashboard gadgets are generally gadgets that have site-wide functionality, such as site analytics or the Activity gadget. Others provide shortcuts to content, such as the Inbox or My Checked-Out Content. The system gadgets available on the Dashboard are as follows:

- **Activity**: Activity shows content with recently performed actions such as a scheduled publish, expire, or upload.
- **My Checked-Out Content**: Shows the content checked out by the current user and the date/time stamp that the content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and clicking the icon checks the page back in.
- **Inbox**: Provides a scrollable list of recently received messages.
- **Site Analytics**: Provides site-level analytics through Google Analytics directly inside OU Campus.
- **Workflow**: Gives users the ability to track all workflow items they are involved in from one gadget. Users involved in a particular workflow item can message each other directly inside the gadget.
Configuring the Dashboard

The **Configure Dashboard** link can be used to choose which gadgets to display on the Dashboard. All users have access to this functionality, but not necessary all gadgets will be visible for all user levels, depending on access settings established by the administrator.

Clicking **Configure Dashboard** brings up the **Dashboard Configuration** modal.
The Dashboard Configuration modal shows the Dashboard gadgets that are available to the user. Gadgets that are currently configured to be available on the Dashboard are listed and can be filtered by name. Functionality includes:

- **Filter**: Enter two or more characters to filter by gadget name.
- **Hide**: To hide a gadget from view on the Dashboard, click anywhere within the green gadget box or click the checkbox to clear the selection. A gadget configured to be hidden is shown in gray.
- **Show**: Click anywhere within the gadget box or the checkbox to select a gadget to show on the Dashboard. A gadget configured to be shown is shown in green.

**Rearranging Dashboard Gadgets**

Gadgets can also be reordered on the Dashboard by clicking and dragging the grey title bar to a new "tile," shown by a dotted line.
Gadgets Sidebar

The Gadgets sidebar is a global element that can be shown or hidden by the user. The sidebar exemplifies responsive design as the sidebar also automatically collapses or expands when a browser is resized. The Gadgets sidebar can be shown by clicking on the Show Gadgets button at the top right of the screen.

Once the Gadgets sidebar has been expanded, individual gadgets can be collapsed or expanded and the user can configure which gadgets appear in the sidebar. The gadgets that are available on the sidebar are dependent upon the implementation of the site and can be configured by a Level 10 administrator.

Gadget Sidebar Icon Reference

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Plug Icon" /></td>
<td>Show Gadgets</td>
<td>Click the plug icon to show the Gadgets sidebar.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Gear Icon" /></td>
<td>Choose Gadgets</td>
<td>Click to display the Choose Sidebar Gadgets modal from where it can be determined which gadgets to show on the sidebar.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>➡</td>
<td>Hide Gadgets</td>
<td>Click the arrow to hide the sidebar.</td>
</tr>
<tr>
<td>⬅</td>
<td>Expand Gadget</td>
<td>Click to expand the gadget on the sidebar.</td>
</tr>
<tr>
<td>⬇</td>
<td>Collapse Gadget</td>
<td>Click to collapse the gadget on the sidebar.</td>
</tr>
</tbody>
</table>

The following system gadgets are published by OU Campus:

- **Activity**: Activity shows content with recently performed actions such as a scheduled publish, expire, or upload. Administrator only.
- **Assets**: Drag and drop any asset into an edit view.
- **Bookmarks**: Bookmark frequently-used pages, reports, or other OU Campus screens for easy navigation.
- **Dependency Tag Info**: Search for and display information regarding dependency tags in the site.
- **Images**: Drag and drop images from any folder into editable regions or the Source Editor.
- **Link Check**: Check for all broken links on a page in OU Campus and send a report to any user.
- **My Checked-Out Content**: Shows the content checked out by the current user and the date/time stamp that the content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and clicking the icon checks the page back in.
- **Notes**: Allows users to make public or private notes on any page in the CMS.
- **Page Analytics**: Allows users to view Google Analytics data for the page they are currently viewing or editing.
- **Page Info**: Displays information about the file currently being viewed or edited.
- **Page Parameters**: Edit page parameters directly from the gadget without having to navigate away from the Preview or Edit view.
- **Quick Publish Gadget**: Allows users to save and publish pages quickly to a desired production target.
- **Request Help**: Sends page and user information along with a custom message to a pre-defined group in OU Campus who can help users in need.
- **Snippets**: Drag and drop any snippet into an edit view.
- **URL Shortener**: Provides a utility to shorten a URL, which can then also be dragged onto a page.
- **Workflow**: Same functionality as the Workflow dashboard gadget.
- **YouTube**: Drag and drop YouTube videos from linked YouTube channels or by searching all of YouTube.

Other gadgets published by third parties are also available in the Marketplace.
Choosing Gadgets on the Gadget Sidebar

To show and hide gadgets in the Gadgets sidebar, click the **Choose Gadgets** icon (circled above) to be taken to the **Manage Sidebar** modal.
The Manage Sidebar modal shows the Sidebar gadgets that are available to the user. Gadgets that are currently configured to be available on the Sidebar are listed and can be filtered by name. Functionality includes:

- **Filter**: Enter two or more characters to filter by gadget name.
- **Hide**: To hide a gadget from view on the Sidebar, click anywhere within the green gadget box or click the checkbox to clear the selection. A gadget configured to be hidden is shown in gray.
- **Show**: Click anywhere within the gadget box or the checkbox to select a gadget to show on the Sidebar. A gadget configured to be shown is shown in green.
Rearranging Sidebar Gadgets

A user may relocate the gadgets on the sidebar by dragging them into a different order. Users can click and hold on the gadget’s title bar and move the gadget up or down in the list.